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Welcome 

Luminar 2018 is a full-featured photo editor for Mac and PC. It brings over 300 robust tools and 
features, including fast RAW support, layers, custom brush for selective editing, masking, dozens of 
photo filters with custom adjustments, presets and a lot more.  Luminar 2018 also brings an 
innovative user interface, that photographers can adjust/customize based on the style of their 
photography, skill level and preferences. This makes Luminar a highly personalized photo software 
tool, suitable for photographers of all skill levels. 
Luminar is the world’s first photo editor that adapts to your style & skill level.  It offers the versatility 
to support many different cameras available as well as styles of photography.  It’s designed to make 
complex photo editing easy & enjoyable. Luminar can help tackle anyone’s photography needs, 
ranging from correcting challenging image problems to artful stylizing. 
Skylum designed Luminar with a scalable, adaptive user interface…  one that’s responsive and 
beautiful. In it you’ll find a powerful set of tools which are easy to use.  We believe it can help all 
photographers from professionals to new photographers. 

• New photographers and mobile shooters will appreciate a simple approach using one-click 
presets and universal tools like cropping, noise reduction and image healing. 

• Casual photographers may start with those same presets, but will soon “graduate” to using 
Luminar’s purpose-built workspaces that offer uniquely tailored tools which achieve great 
results quickly. 

• For passionate enthusiasts and professionals, workspaces and the full gamut of editing tools 
such as brushes, layers, blending modes, texture overlays, an editing history menu and 
much more herald a new generation of advanced photo editing possibilities. 

Skylum is one of the world’s leading developers of consumer and professional photography 
software, serving over 35 million customers worldwide.  Using experience gained over more than 
10 years of delivering mobile and desktop software, Luminar is truly a state-of-the-art tool for any 
photographer seeking to improve their photos. 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Key Features and Benefits of Luminar  

• A scalable and adaptive user interface that let’s you work the way that you want. 

• Powerful workspaces designed for specific types of photography such as Default, Black & 
White, Landscape, Portrait, or Street photography as well as the option to create your own 
custom workspaces 

• Over 60 powerful one-click presets to quickly enhance your images. 

• 50 image enhancement filters to refine your photos and solve image problems. 

• Layers, brushes and masking provide the ultimate in selective editing. 

• Customizable brushes plus a selective masking system to allow for precise control. 

• A History panel to track which adjustments have been made to an image as well as quickly 
perform multiple undos. 

• RAW, JPEG, TIFF and other popular files support for the greatest flexibility. 

• Workflow tailored to any style with support for using as a standalone application or as a 
plug-in to popular host applications. 

• Ability to host Photoshop plug-ins. 

• Batch processing of photos to quickly improve multiple images. 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Key New & Improved Benefits of Luminar 2018 

There are several new features as well as improvement in Luminar 2018 to help you create fantastic 
images in less time. 

User Interface/Performance 
• NEW: Quick Overlay Preset button 
• NEW: Expand / Collapse mode for filters  
• IMPROVED: Updated workspaces for increased efficiency 
• IMPROVED: Innovative adaptive user interface, based on user needs and skill 
• IMPROVED: up to 4x faster RAW image processing 
• IMPROVED: up to 2x faster masking performance 
• IMPROVED: Over 150% speed increase  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Editing 
• NEW: Dedicated Raw Develop filter  
• NEW: New brush modes in layers  
• NEW: Sun Rays filter 
• NEW: LUT Mapping filter 
• NEW: Dodge & Burn filter 
• NEW: Hue Shift filter 
• NEW: Matte Look filter 
• NEW: Brilliance/Warmth filter 
• NEW: Lens Correction tool 
• NEW: Transform Tool 
• NEW: Free Transform Tool 
• NEW: Image Flip & Rotate 
• NEW: Realtime noise reduction 
• IMPROVED: RAW file handling (reveals more details in shadows/highlights, displays colors 

more accurately and reduces noise) 
• IMPROVED: Crop tool 
• IMPROVED: Advanced masking with filters  
• IMPROVED: Advanced Bi-Color Toning  
• IMPROVED: Advanced Cross Processing  
• IMPROVED: Advanced Image Radiance  
• IMPROVED: Advanced Microstructure 
• IMPROVED: Advanced Split Toning  
• IMPROVED: Advanced Structure  

Open/Plugin/Export 
• NEW:  Support other Skylum apps as plugins 
• NEW: Support for many third-party Photoshop-style plugins 
• NEW: Apple HEIF files support  
• IMPROVED: Native RAW file support, including better DNG handling 
• IMPROVED: Sharpen on export 
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Installing and Activating Luminar 

There are two ways to install Luminar on your computer.  The method you choose will depend upon 
how you purchased Luminar. 

Installation for a Mac 
1. Click the download link in your activation email (sent after purchase). 
2. Locate the installer in your Downloads folder. 
3. Double-click Luminar_2018.dmg open the installer. 
4. Drag the application into your Applications folder. 
5. Choose Go > Applications to navigate to your Applications folder. 
6. Locate the Luminar 2018 application and double-click to launch. 
7. Enter the email address you used when purchasing the software and your activation key 

(from your activation email) to complete installation and registration. 
8. Click Activate to launch the application.  

If you ever lose your activation key, you’ll be able to provide our support team with your email 
address and they can restore the activation code for you. You can also look up your products and 
keys at https://skylum.com/support. If you purchase software from our website, you’ll need to 
download and install your software.  Follow these steps. 

If Bought from the Mac App Store 
If you choose to purchase Luminar from the Mac App store, please follow these steps. 

1. Launch the Mac App Store. 
2. In the Search field type Luminar. 
3. Locate Luminar and click the Buy button. 
4. The Mac App Store may ask you to verify your ID and password. 
5. Luminar is downloaded to your Applications folder. 
6. In the Finder choose Go > Application and locate the Luminar application. 
7. Double-click on the Luminar app to launch and use the application. 

If you ever delete the Luminar application, you can re-download it from the Mac App Store. 
__________________________________________________ 

Note 
The Mac App Store version of Luminar doesn’t offer the ability to be used as a plug-in. To get a 
version that can, please  contact support@skylum.com.  Just provide proof of purchase and they will 
give you a version that can be used as a plug-in. 
_________________________________________________ 

Page !  of !6 155

https://skylum.com/support
mailto:support@skylum.com


Installing Plugins into Luminar 
If you own additional Photoshop style plugins, those can be used with Luminar 2018.  This includes 
plugins such as Aurora HDR (for Mac and PC) and Creative Kit (Mac).  You can also access many 
third party plugins.  When Luminar is installed, it will attempt to locate any third-party Photoshop 
plugins installed on your system.   
To use a plugin: 

1. Open an image into Luminar 2018. 
2. Click the Plugins menu 

• You can choose from Skylum plugins. 
• You can choose Plugins > Other to see autodetected plugins installed on your system 
• You can choose Plugins > Choose plugin… to navigate directly to an installed plugin to 

open it. 
3. The image is opened up in the plugin. 

You can now make any desired edits. 
4. Click OK or Apply in the plugin to render its result and return the image as a new layer in 

Luminar 2018. 

Page !  of !7 155



System Requirements for Mac OS 

Luminar 2018 Mac  
• MacBook, MacBook Air, MacBook Pro, iMac, iMac Pro, Mac Pro, Mac mini 
• Processor Intel 64-bit Core 2 Duo or better 
• Mac from early 2010 or newer. 
• Memory 8 Gb RAM or more 
• macOS High Sierra 10.13.1, Sierra 10.12.6, El Capitan 10.11.5, Yosemite 10.10.5 
• Hard disk 2 GB free space, SSD for best performance 
• Display 1280x768 size or better 

You can check your system specifications and hardware by choosing  > About this Mac.  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Installing Luminar as a Plug-in 

While Luminar is a full featured stand-alone application, some users also choose to install and run it 
as a plug-in for other popular photo editing software.  If you installed after downloading from our 
website, you should be prompted to install the plug-ins for detected software you already have 
installed. 
If you choose to install as a plug-in at a later time, you can easily do so. 

1. Make sure Luminar is open. 
2. Simply choose Luminar > Install Plug-ins… to start. 

3. A new dialog box appears to show you which supported host applications you have 
currently installed on your Mac. The host applications supported by Luminar are: 
• Adobe Photoshop 
• Adobe Photoshop Lightroom 
• Adobe Photoshop Elements 
• Apple Aperture 

4. Click the Install/Uninstall button for the corresponding apps in which you’d like Luminar to 
run. In addition (though it’s not listed in this plug-in dialog box) Luminar will operating as an 
editing extension in Photos for Mac. 

__________________________________________________ 

Note 
For best results, quit the host application (such as Photoshop) before you install a plug-in. You may 
be prompted to input your Administrator password to complete the installation. 
__________________________________________________ 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Using Luminar with Adobe Photoshop / Photoshop Elements 
Luminar is a powerful addition to Adobe Photoshop.  To apply Luminar as a filter, follow these steps: 

1. Make sure Adobe Photoshop or Adobe Photoshop Elements is open. 
2. Open an image you’d like to enhance. 
3. Choose Filter > Skylum Software > Luminar 2018…  

A new dialog appears to indicate that Luminar is running. 
4. Luminar should automatically open the image you were editing.  

If needed, click the Luminar icon in your Dock to switch to Luminar. 
5. Make any edits or adjustments as needed in Luminar.  Use presets or workspaces to speed 

up your editing workflow. 
6. When done, click the Apply button to send the adjusted image back to Photoshop. 

__________________________________________________ 

Note 

Luminar can operate as a Smart Filter in Photoshop. If you designate a Photoshop layer as a Smart 
Filter, then launch the Luminar plug-in as normal to make edits. When you return to Photoshop you 
can always double-click on the layer and return to Luminar with all edits intact. 

__________________________________________________ 
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Using Luminar with Adobe Lightroom Classic CC 
Images in Adobe Lightroom Classic CC (or Lightroom 6) can be easily handed off for editing in 
Luminar. To exchange a file from Lightroom Classic CC to Luminar, follow these steps: 

1. Make sure Adobe Photoshop Lightroom Classic CC is open. 
2. Choose your image(s) in Lightroom Classic CC                                                                                                                                                                                                                                                     

from the Library or Develop modules that you want to work on with Luminar. 
3. Choose Photo > Edit In > Luminar 2018 or right-click on the Image and select Edit In > 

Luminar 2018. 
4. A new dialog opens.  Depending upon the 

type of file selected you’ll need to make a 
choice. 

• Edit a Copy with Lightroom 
Adjustments.  This is the default action 
for raw files or images that have been 
edited.  Any adjustments made in 
Lightroom can be applied to a high-
quality TIFF. 

• Edit a Copy. This option takes the 
original photo and makes a duplicate 
high-quality file for editing.  This option 
works well for non-raw files or if you want 
to reset a raw file to no adjustments 
before editing. 

• Edit Original.  The original file is opened 
directly in Luminar.  This workflow will 
overwrite your original file and isn’t 
recommended for most users. 

5. Click Edit to send the file to Luminar 2018. A new file is added to your Library and stacked 
with the original in your Library. 

6. Click the Luminar icon in your Dock to switch to Luminar. 
7. Make any edits or adjustments as needed in Luminar.  Use presets or workspaces to speed 

up your editing workflow. 
8. When done, click the Apply button to send the adjusted image back to Lightroom. 
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Using Luminar with Apple Aperture 
Working with Luminar through Aperture is very similar to the way it behaves with Lightroom. To 
exchange a file from Aperture to Luminar, follow these steps: 

1. Make sure Apple Aperture is open. 
2. Choose your image(s) in Aperture from the Library that you want to work on with Luminar. 
3. Choose Photo > Edit In > Luminar or right-click on the Image and select Edit In > Luminar. 

4. A new image is created and sent to Luminar. 
5. Make any edits or adjustments as needed in Luminar.  Use presets or workspaces to speed 

up your editing workflow. 
6. When done, click the Apply button to send the adjusted image back to Aperture. 
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Using Luminar as a Photos for Mac Extension 
If the version of the macOS system on your Mac is newer than 10.11 you can use Luminar as an 
extension to Photos for Mac. Here’s how to activate the Extension. 

1. Choose  > System Preferences. 
2. Choose Extensions. 
3. Choose Photos. 
4. Select the extensions that you'd like to use. Be sure to mark Luminar 2018. 

5. Launch Photos for Mac from your Applications folder. 
6. Choose an image to edit in your Photos library. 
7. Click the Edit Photo button. 
8. Click the Extensions button and choose Luminar. 
9. Make any edits or adjustments as needed in Luminar.  Use presets or workspaces to speed 

up your editing workflow. 
10. When done, click the Save Changes button to send the adjusted image back to Photos  

for Mac. 
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Opening Images 

Luminar offers many easy-to use as well as powerful controls to improve your image.  The first step 
of course is opening a picture within the application.  

How to Open a Photo 
There are several ways to open images based on your personal preference.  Each of these four 
methods generates the same outcome, so choose the one that works best for you. 

1. First, launch Luminar. 
2. You can now open a supported file format using any of these methods. 

• At the startup screen, click the Open Image button to navigate to and open a file. 

• Choose File > Open… to navigate to and open a file. 

• To open an image you recently edited, choose File > Open Recent. 

• You can also drag a photo directly onto the Luminar application in the Dock. 

3. Your photo opens into the Canvas ready for editing. 

__________________________________________________ 

Note 
The image background can also be changed. By default it is dark gray. But it can be lightened, as 
desired. Select the menu item View > Background or right-mouse click on the image background to 
select a new background color for the image. 

__________________________________________________ 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How to Develop a RAW Photo 
When working with raw files, it is recommended that you apply the Raw Develop filter to the image 
in order to fine-tune the raw image. You can apply the filter to any raw photo: 

1. Make sure an image is open in Luminar. 
2. Click the Add Filters button. 
3. Choose RAW Develop from the Essential category of filters. 

You can only have one instance of this effect and it will always apply at the top of the filter 
stack before other filters. 

4. You can also apply the RAW Develop filter by using some of the built-in workspaces. 
__________________________________________________ 

Note 
A close equivalent to the RAW Develop filter is the similarly named Develop filter.  This is designed 
for use on non-raw files such as TIFF or JPEG.  You can only have one RAW Develop or Develop filter 
applied per image. 

__________________________________________________ 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Adjust 
The Adjust tab contains the essential color and tone adjustments that should be made using the 
raw file.  This sets the stage for all the adjustments that come after. 

• Profile. Are you looking for truly professional 
control over your raw files?  Be sure to give 
Digital Camera Profiles a try. Luminar 
recognizes the industry standard DCP files that 
you may already have on your computer (or 
have bought from third parties). These offer 
greater control over how the color and tone in 
the raw file is handled. Need a bunch of free 
DCP profiles? Just install the free DNG 
Converter from Adobe. 

• White Balance. Use the White Balance preset 
list to choose from a variety of presets that are 
similar to a camera’s white balance menu. 

• Temperature. Use this slider to warm or cool a 
shot.  This adjustment essentially adds Cyan or 
Yellow to an image to change its color 
temperature. 

• Tint. This adjusts the amount of Green or 
Magenta that is added to a shot.  It is useful for 
removing color casts from an image. 

• Exposure. Adjusts the global luminance of the image. Moving this slider to the left results in 
a darker image (reduction of exposure value). Moving this slider to the right results in a 
brighter image (increase of exposure value). 

• Contrast. Adjusts the contrast of the image. Contrast is the difference in luminance or color 
that makes an object in an image distinguishable from another. Practically speaking, contrast 
is determined by the difference in the color and brightness of an object in relation to other 
objects within the same field of view. 

• Highlights. Adjusts the brightness of the brightest areas of the image. Moving the slider to 
the right cause very bright areas to become brighter, while moving the slider to the left, 
makes them darker. 
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• Shadows. Adjusts the brightness level of the darkest areas of the image. Moving the slider 
to the right will cause such areas to become brighter and additional details will appear. 
When moving to the left, such areas become darker, and the number of shadow areas in the 
image generally increases. 

• Whites. Adjusts the white point of the histogram and white tones in the image. When 
moving to the right, the brightest tones will become brighter while the histogram stretches 
to the right. Moving the slider to the left will cause white tones in the image to become 
darker and the histogram to compress to the left. 

• Blacks. Sets the black point of the histogram or black tones in the image. Moving the slider 
to the right, black tones become brighter and the histogram compresses to the right. 
Moving the slider to the left, black become darker and the histogram stretches to the left. 

• Clarity. Allows users to increase the contrast in the midtones introducing more depth 
between the relationships of values that lie in the middle of the histogram. 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Lens Correction 
This set of controls lets you apply lens corrections to a photo.  These are designed to remove flaws 
in the image cause by the lens or  handling.  The Lens Correction command easily fixes all kinds of 
lens distortion, from barrel and pincushion to chromatic aberration and vignetting. 

• Auto Corrections.  These are three automatic 
corrections that can fix your image.  They are 
designed to quickly fix common problems. 

• Lens Distortion. Click this option to 
remove lens distortion automatically. The 
filter analyzes your image and its metadata 
to calculate an automatic fix that you can 
apply in one-click. Get rid of wide angle 
distortion and get truer perspective lines 
and more attractive portraits. 

• Chromatic Aberration FIx. Chromatic 
aberration is a type of color fringing.  It 
often happens on telephoto lenses and in 
areas of high contrast.  It tends to show up 
as magenta or green edges. 

• Defringe.  This adjustment can remove 
halos or edge noise (particularly in high-
contrast areas). 

• Lens Distortion. Drag to the left to increase the barrel shape of the lens.  Drag to the right to 
pinch and compensate for wider angle lenses. You may need to crop the layer or use the 
Scale command in the Transform controls to compensate for gaps at the edges. 

• Devignette. Removes any darkening at the edges of an image caused by the lens itself.   
This is a corrective command, not a stylizing command.  If you want an artistic vignette, be 
sure to explore the Vignette filter. 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Transform 
It is also possible to transform the shape of a photo to compensate for perspective issues or 
problems caused by the camera’s physical position.  With the Transform tool there are many options 
available for changing the position, rotation, and scale of a layer. The Transform tab is the third tab 
in the Raw Develop and the Develop filter. 
Adjust any of the following properties as needed to transform the image: 

• Vertical. This tilts the image by rotating on the 
X-axis.  This tilts the image forwards or 
backwards and can help compensate for an 
image with any keystoning problems.  This type 
of problem causes vertical lines to appear 
skewed and is often caused by the camera 
shooting from age by rotating on the Y-axis.  
This angles the image from side to side and 
solves the problems caused by shooting at an 
angle in relation to the subject. 

• Horizontal. This adjustment tilts the image on 
the Y-axis.  It can help compensate for 
perspective issues caused by shooting off-angle 
from your subject. 

• Rotate. Rotates the entire canvas on the Z-axis 
and can be useful for straightening a crooked 
photo. 

• Aspect.  This command changes the aspect 
ratio of a photo. Dragging the slider will expand the height or the width while contracting 
the opposite direction for the second value.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                

• Scale. Use the Scale command to effectively crop the transformed photo.  This is a useful 
way to hide gaps after transforming a photo. 

• X Offset. This shifts the transformed image left or right. 

• Y Offset. This shifts the transformed image up or down. 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Supported File Types 
Luminar is designed to open a wide range of file formats.  This ensures compatibility with most 
cameras as well as common graphic formats.  Supported file types include: 

GRAPHIC FORMATS 

• PNG 

• JPEG 

• TIFF (8-bit and 16-bit) 

• Apple HEIF files 

• PSD (Mac only) 

POPULAR RAW FORMATS 

• .CR2 

• .NEF 

• .ORF 

• .RAF 

• .ERF 

• .ARW 

• .RW2 

• .DNG 

• .PEF 

• .PPM 

• and more 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User Interface Overview 

Working with Luminar, you’ll access controls from three primary areas.  The Top Toolbar contains 
general-purpose and frequently used functions of the software.  The Side Panel is located to the 
right of the main image display; all adjustment tools, layers and the histogram can be found here. 
The Side Toolbar contains useful tools to edit your images. You can also save time with the Preset 
Panel which offers one-click presets at the bottom of the screen. 

Top Toolbar 
As you work with an image, the Top Toolbar contains many commands that you’ll frequently use.  
These are grouped logically for easier use. 

Open Button 
The first button controls how files are opened, processed, and exported.  Clicking the Open button 
reveals two choices. 

• Open Images. The first choice is used to load new images for processing. The shortcut is 
Cmd+O. 

• Batch Processing. The second 
choice opens up the Batch 
Processing dialog box. This is a 
way to process multiple images 
at one time. The shortcut is 
Cmd+B. 
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Zoom Buttons 
These next three buttons are used for changing your view of the image size in the canvas. If you go 
from left to right the buttons do the following. 

• Magnification Level.  The first 
menu controls the zoom level.  
Click the dropdown menu to 
choose from a preset. 

• Zoom Out.  This option reduces 
the  view size of the displayed 
image. The shortcut is Cmd+- 
(minus). You can see the current 
zoom level in the magnification 
level field.  

• Zoom In. This option increases 
the  view size of the displayed 
image. The shortcut is Cmd+= 
(equals). 

• To see the Original Size  press Cmd + 1 to view a 100% magnification showing the pixels in 
actual size.  To Fit to Screen press Cmd + 0 and the image will size itself to the canvas. 

Comparison Buttons 
These buttons allow you to compare the original image with the original default image, so you can 
easily compare how your enhancements changes the original image.  

• Quick Preview. The eyeball icon 
can quickly toggle between the 
original image and the enhanced 
version.  Another way to see this 
change is to use the keyboard 
shortcut \ (backslash).  This allows 
you to quickly compare the current image with the original. This is the fastest and most 
convenient mode of comparison. 

• Compare Button. This button activates a comparison where the image is divided by a 
vertical strip (“curtain”). The original image (Before) is displayed on the left, and the current 
result (After) is on the right. This vertical strip can be dragged left or right, so you can view 
the differences in the picture. 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Undo/History Buttons  
The next two buttons control the Undo command as well as let you view an image’s History.  These 
two buttons give you complete control over reverting to an earlier state of an image. 

• Undo. The Undo Button 
(curving left arrow) cancels the 
last action (for example, 
changing a slider). This is useful 
to go back to an earlier step. 

• History Panel. The History 
panel will quickly become an 
essential part of your workflow. 
It’s here that Luminar keeps a list 
of what you have done to the 
image since you opened it. 
These are multiple undos and 
an easy way to go back in time.  
Simply click on an early History 
State to revert the photo to that 
stage of editing.   
 
History states are also saved with an image when you store it in the native Luminar (.lmnr) 
file format.  This allows for a nondestructive editing workflow and let’s you revert to an 
earlier version of the image. 

Page !  of !23 155



Tools Menu 
The Tools menu holds specialty tools that help you modify an image or layer.  These tools will be 
explored in-depth later in this guide. 

• Crop Tool (C). The Crop tool 
allows you to hide parts of an 
image to change its 
composition or to prepare it for 
display at a certain size or 
aspect ratio (such as a 5X7 
print).  The Crop tool also makes 
it easy to align (straighten) the 
horizon in an image if it’s not 
horizontal.  You’ll learn more 
about cropping in the chapter 
“Crop & Transform a Photo.” 

• Free Transform Tool (Cmd + T). This tool makes it easy to transform a layer.  Once active 
you can drag a handle at the side of the image to resize the width or height.  Click the Lock 
icon in the info area if you want to force the image to maintain its original shape.  You can 
also enter a specific size in pixels by clicking on a number. 

• Clone & Stamp Tool (Cmd + J). The Clone & Stamp tool lets you sample pixels from one 
part of the image (just hold down the Option key and click on the source pixels).  You can 
then click and paint in another part of the image to add those pixels into a new area.  You’ll 
learn more in the chapter “Removing an Object.” 

• Erase Tool (Cmd + E). The Erase tool is similar to the Clone & Stamp tool.  The key 
difference is that you don’t need to choose where to sample pixels from.  Simply click and 
paint on an unwanted object and pixels surrounding it will blend and try to remove the 
object from the image. You’ll also learn more about erasing in the chapter “Removing an 
Object.” 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View Preset Panel/Side Panel Buttons 
The next two buttons affect which controls are visible.  You can choose to hide options like the 
Preset Panel and Side Panel to make a larger preview image. 
• Show/Hide Preset Panel. The Preset 

Panel on the bottom of the Luminar 
2018 workspace is where you’ll find 
all of your presets.  These include 
those created by the Luminar team as 
well as your own custom presets.  To 
hide the Preset Panel, just click the 
button to toggle visibility or use the 
Tab key to hide both the Side and 
Preset Panels. 

• Show/Hide Side Panel. The Side Panel on the right side of the Luminar 2018 workspace is where 
you’ll find the Histogram, Layers, and Filters controls.  This area is a fixed width and is always 
displayed on the right.  To hide the Side Panel, just click the button to toggle visibility or use the 

Tab key to hide both the Side and Preset Panels.  

Share Image Button 
The last button in the top Toolbar is used to share an 
image from the application to other applications. The 
same image can also be shared with other editing 
software from Skylum (and others) or uploaded directly 
to social networks and other online services. 

• Export to Image.  Creates a new file in a common 
image format. 

• Services.  Choose to send to system applications, 
upload directly to social networks, or share with 
other online services. 

• Open In. Send to other Skylum applications or 
instances of the Luminar plugin for other host 
applications. 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Side Toolbar 
The Side panel gives you access to three important sets of controls.  The Histogram is a useful tool 
for judging exposure and details. Layers lets you work with multiple objects to create a composite 
image or to isolate effects or textures to their own place.  The Filters section gives you precise 
control over each filter you’ve added to a layer. 

Histogram /Layers / Info Buttons 
At the top of the side panel are three 
buttons that provide advanced controls 
over your images.  If you are just 
getting started with Luminar 2018, you 
might leave these three options 
deactivated.  However, as you grow 
comfortable with editing tasks or are 
looking for the most flexibility  and 
control, be sure to explore them. 
• Histogram – While color correcting 

or adjusting exposure, the histogram 
can be a great help. This graph 
illustrates how the pixels in the image 
are distributed across brightness 
levels.  More on the Histogram in the 
next section. 

• Layers – In Luminar, a layer can contain image, transparency, and filter information. This allows you 
to combine (or composite) multiple images into a new image as well as make complex 
adjustments with maximum flexibility.  By isolating discrete elements to their own layers, it is 
easier to control options such as transparency and blending. For most users, it’s a good idea to 
leave your Layers panel open while you work; this is where most of the action takes place. The 
Layers panel is like the steering wheel of a car. We’ll explore layers in depth in the chapter 
“Working with Layers.” 

• Info – The Info Bar provides basic information about the file and can help you better understand 
your image, as well as its resolution.  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Histogram 
While color correcting or adjusting exposure, the histogram can be a great help. A histogram is a 
graphical representation of the tonal values of your image. This graph illustrates how the pixels in 
the image are distributed across brightness levels. In other words, it shows the amount of tones of 
particular brightness found in your photograph ranging from black (0% brightness) to white (100% 
brightness). Ideally, well balanced images will have tonal values across the entire range of the 
histogram. 

To read a histogram, start at the left edge, which shows the shadow regions. The middle shows the 
midtones (where most adjustments to an image are made), and to the right are the highlights.   
The histogram is able to display Red, Green, Blue channels separately or, by default, shows all of 
them at once.  Click on the Histogram to switch between seeing a composite Histogram or just 
viewing details about the Red, Green, and Blue channels (which can be useful for spotting tint 
issues and color casts). You can also see a grayscale average for luminance. 

Additionally, clicking the two small triangles in the upper left  and upper right corners will show hot 
and cold pixels respectively.  These are pixels that have shifted or exposed to become absolutely 
black or white pixels.   
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• Cold Pixels – To enable or disable the display mode of absolutely black pixels, click the 
triangle on the left and the histogram is clipped on the left side. Absolutely black pixels will 
be displayed in bright blue in the image.  Cold pixels (in blue) indicate areas where black 
has achieved maximum concentration (a zero value). 

• Hot Pixels –  Clicking the triangle on the upper right will show where your image is 
completely white, where the histogram is clipped on the right side. Absolutely white pixels 
are displayed in red. 

In both cases this can be problematic (especially for printing) as there is too much ink coverage for 
cold pixels and no details at all in the hot pixels.  These indicators are a sign that you should adjust 
the exposure of the image. You may want to leave the Histogram panel open as you work, because 
it is an easy way to learn to read the graphical details of a digital image. 
__________________________________________________ 

NOTE 
The use of the Develop and RAW Develop filters are an excellent way to take control of the Black 
and White points as well as the Shadows and Highlights of an image.  Pressing the J key will also 
toggle the clipping indicators On and Off if you want to see the pixels underneath. 

__________________________________________________ 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Layers 
Layers are a powerful way to “build up” your images, with different enhancements and use of 
blending modes on each layer. Using layers, you can apply corrections or enhancements on 
different layers, and experiment until you achieve exactly the look you’d like for your image. 

• To create a new layer.  
Click on the + button in the 
Layers Toolbar header.  A small 
pop-up menu will appear giving 
you the option of creating a 
layer using one of two options.  
Use an Adjustment Layer to 
create a layer to which you can 
apply a preset or any other 
adjustment in the Filters panel. 
The Add Image option will 
show a standard Open File 
dialog, allowing you to create a 
new layer with a texture file or another image that you’ve chosen. 

• To remove the layer. Select the layer and click - in the Layers Toolbar title. 

• To change the blending mode of the layer. Set the Layer Blending mode in the drop-
down list under the word Layers or in the fly-out menu indicated by the Gear icon 
underneath the + icon. You cannot set the blending mode for the first layer because it is not 
mixed with anything — it is the baseline image. More on blending modes in the chapter 
“Working with Layers.”  

• Layer Transparency Setting. Click on the drop-down menu with percentages near the word 
Opacity. Drag the slider to customize the opacity for the selected layer.  Opacity controls 
how opaque a layer is (and is the opposite of transparency). 

• Access Advanced Settings and Functions of a Layer. Click on the Gear icon below the + 
icon. A context menu appears with additional features to apply to the layer. 

• To Change the Order of Layers. All the layers except the first are movable. Click on the 
layer and drag to move the selected layer to the new location.  Changing the stacking order 
or layers can affect the order of operation (how images are developed) which can change its 
appearance. 

• Show / Hide the Layer. Click on the eyeball on the left side of a layer to toggle between 
visible and hidden. 

You’ll learn more about layers in the chapter “Working with Layers.”  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Info 
The Info Bar provides basic information about a photo.  Some of this information is always visible 
and the rest can be toggled on or off. When the Info button is activated, this information is 
displayed from left to right: 

• ISO. The ISO of the image when 
captured. 

• Focal Length. The focal length 
for the lens used when shooting. 

• Aperture. The ƒ-stop for the images. 

Additional information is always shown about your image. 

• Resolution. The current resolution of the image in pixels. 

• Bit Depth. Luminar supports working in 8-bits per channel for JPEG and 16-bits per channel 
for RAW files. 

Filters 
Filters are how you can adjust the exposure, color, contrast, and style of your image in Luminar 
2018.  The proper use of filters can significantly improve your image.  Each filter is designed to 
solve specific problems or enhance an image in a particular way. The Filters section of the side 
panel shows any filters you have applied or that are included in a workspace.   
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Filters can be stacked in any order to change their order of operations.  You can also add masks to 
filters to control their results.  Filters can also have other properties like their blending mode and 
visibility adjusted.  
You’ll learn more about each filter in the chapter “Using Filters.” 

Workspace Switcher 
Luminar offers workspaces to streamline your approach to editing. Each workspace is a customized 
group of filters designed for a particular style of editing.  Luminar offers pre-built workspaces that 
have been designed for particular tasks. You’ll find that using Luminar’s purpose-built workspaces 
offer uniquely tailored tools which achieve great results quickly.  

Preset Panel 
The Preset Panel contains all of the one-click Presets available in Luminar 2018. These presets can 
be applied to any open image or to a new Adjustment layer.  To apply a preset, simply click on its 
thumbnail.  To adjust the intensity of the effect, use the Amount slider to blend the adjustment. We’ll 
explore presets in depth in the next chapter. 
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Mac Touch Bar  
If your Mac offers a Touch Bar, you can take advantage of it for easy access to specific tools while 
editing. The Touch Bar will change which controls are shown based on what you are currently doing 
inside the application. 

Standard Touch Bar 
The standard toolbar gives you controls similar to the top toolbar. 

• Quick Preview. The eyeball icon can quickly toggle between the original image and the 
enhanced version. 

• Compare Button. This button activates a comparison where the image is divided by a 
vertical strip (“curtain”). The original image (Before) is displayed on the left, and the current 
result (After) is on the right. 

• Show/Hide Preset Panel. Just click the button to toggle visibility of the Presets Panel. 

• Show/Hide Side Panel. To hide the Side Panel, just click the button to toggle visibility. 

• Undo. The Undo Button cancels the last action (tap multiple times for additional undos). 

• Crop Tool ©. The Crop tool allows you to hide parts of an image to change its composition 
or to prepare it for display at a certain size or aspect ratio. 

Commit Touch Bar 
This toolbar is shown when certain tools are activated (such as Crop and Free Transform). 

• Reset. This reverts the tool back to its original state. 

• Apply. This commits the change for the selected tool. 

Brush Touch Bar 
If working with a brush tool, you can quickly adjust the size of the brush from the Touch Bar. 
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Clone & Stamp Touch Bar 
If working with the Clone & Stamp tool, you can modify its essential controls from the Touch Bar. 

• Size. Drag to increase the size of the tool. 

• Brush. Activate the bush mode. 

• Hand Tool. Switch to panning the image. 

• Apply. This commits the change for the selected tool. 

Eraser Touch Bar 
If working with the Eraser tool, you can also modify its essential controls from the Touch Bar. 

• Size. Drag to increase the size of the tool. 

• Add. Adds to the currently selected pixels when painting. 

• Subtract. Subtracts from the selected area when painting. 

• Erase. Removes the selected pixels from the image and generates new pixels based on the 
surrounding area. 

• Apply. This commits the change for the Eraser tool. 
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Working with Presets 

Presets allow you to make instant changes to your image with one click of a button. Each preset is 
made up of all the saved filters as well as the settings used for each of those filters.  Presets can also 
include Blending Mode and Opacity changes made to a filter or a layer. For each layer or 
adjustment layer, a different preset can be applied, which can make for some creative results! 

Applying a Preset 
In order to save time when developing your image, you’ll find an extensive collection of presets. 
Professional photographers from around the world have helped us create a comprehensive group 
of presets that give your images amazing enhancements in a single click. 
To apply a preset: 

1. Make sure an image is open in Luminar. 
2. If the Preset Panel isn’t visible, click its icon in 

the Top Toolbar.   
The Preset Panel will open at the bottom edge 
of the screen. You can click the Preset Panel 
button in the Top Toolbar to toggle displaying 
and hiding the presets filmstrip bar on the 
bottom of the window. 

3. Examine the presets available by exploring 
their thumbnails at the bottom of the page.  Each offers a live preview as what the image 
would look like with the Preset applied. 

4. Click on a Preset thumbnail to apply it. You can quickly switch presets by clicking on a new 
thumbnail. You can also use the right and left arrow keys to switch presets. 
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5. You can quickly switch presets by clicking on a 
new thumbnail. To view all the presets in a 
given category, simply use the arrow keys on 
your keyboard or the horizontal scrollbar 
located at the bottom of the Luminar 2018 
window. 

6. If you hover your mouse over a preset an 
Amount slider is revealed, with the default set 
to 100% opacity. By moving the Amount slider 
located within the Preset name you can lower 
the intensity that the effect has on your image. 

7. Click the Star icon on a preset thumbnail to add 
it to your Favorites list for easy access. 

Applying a Preset as an Overlay Preset 
If you’d like to experiment with presets more freely, be sure to try out adjustment layers.  An 
adjustment layer is an empty layer that can hold filters.  This layer is placed above your image and 
allows for easier control over blending modes and opacity.  It’s also easy to mask an adjustment 
layer to control which parts are seen (more on masking later). 
An easy way to apply a preset to a new adjustment layer is to user the New Preset Overlay feature. 

1. Make sure an image is open in Luminar. 
2. Make sure the Presets panel is open. 
3. Click the Overlay Preset button in the 

upper-right corner of the preset area. 
A new adjustment layer appears. 

4. Choose the preset that you’d like to use 
and click its thumbnail. 

5. If you’d like to try a different preset, just 
click another preview thumbnail. 

6. Experiment by adjusting the Blending 
Mode and the Opacity for the Overlay 
Preset layer. 
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Loading Additional Presets 
There are many presets included with Luminar.  To make it easy to manage these presets, you’ll find 
that they are organized into several groups and categories. 

Choosing a Group 
Presets are organized into three major groups. To view these options click the circular icon at the 
right edge of the Presets Panel.  This will open up the Group and Category browser.  

• All Presets shows you both presets created by the Skylum team as well as any that you’ve 
saved or imported. 

• Favorite Presets are the presets that you tagged with a star (just click the hollow star on a 
preset’s thumbnail). Use these presets to create a consistent edit across a series of images or 
to keep a shortlist of your favorite adjustments. 

• User Presets shows you presets that you’ve created on your own. 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Choosing a Category 
Presets are also organized into Categories to help sort them by style.  These categories include 
presets created by Skylum and professional photographers. To view by category, click the circular 
icon at the right edge of the Presets Panel and choose the All Presets group.  You’ll now see several 
categories to choose from, including: 

• Basic. These presets create 
subtle changes in your image 
for clarity, vivid colors, adding  a 
vignette, and more. 

• Street. These work well for 
photographs shot under on-the-
move conditions.  Bring out 
detail and add contrast to your 
images quickly. 

• Outdoor.  A collection of 
presets that are well-suited for outdoor lighting.  Use these presets to quickly add contrast, 
make colors vivid, improve skies, or add details with structure. 

• Portrait. Enhance the look of people by smoothing skin tones and bringing back warmth 
and color to your subject. 

• Travel.  Apply subtle adjustments to both color and contrast.  These presets are useful for 
evoking a mood and are a quick way to stylize your photos. 

• Dramatic. Use these presets to create images that offer a dramatic flair.  Looks include 
presets to create desaturated colors, high-contrast tones, rich colors, big glows, or soft focus. 

• Aerial Inspired by DJI. These preset are perfect for photos taken from your drone.  They are 
optimized to bring out the most detail in aerial photos while cutting down on haze and 
sharpening the image. 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Customizing Presets 
Remember, a preset is merely a starting point. Different photographers will desire different looks.  
Plus a preset may work great on some photos, but need a little tweaking for others.  Once you 
select a preset, you have the ability in the Side Panel to use Filters controls to modify that preset to 
fit your specific image needs. 

Saving Custom Presets 
As you adjust presets or build your own recipes from scratch, you may find a particular combination 
that you like.  Custom presets can function as the jumping off point for your own look and style. A 
preset can store a lot of control in an easy, one-click effect. 

1. Adjust an existing preset or add 
your own effects to an image. 

2. Click the “Save Filters Preset” 
button in the lower-right area of 
the Filters controls. 

3. A dialog will pop-up at the top 
of the window asking you to 
name your preset. Give it a 
descriptive name to help you 
remember which situations to 
use the preset. 

4.  Click the Create New Preset 
button to store the preset. Once 
you've added the preset, it will 
appear in the User Presets group. 
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Modifying Custom Presets 
There are additional features for user presets that are not available for the built-in presets. You 
must be viewing all preset or the User Presets category to see these options. 
 To access this menu for a user preset, 
click the small triangle next to a presets 
name while hovering over the preset’s 
thumbnail image. 

• Update with Current Settings. 
To overwrite or re-save the 
preset with the current state of 
the sliders in the Filters controls. 

• Delete. Deletes the current user 
preset. 

• Rename. Renames the current 
preset. 

• Show in Finder. Opens a Finder 
window for the currently selected preset file. This allows you to copy the preset and pass it 
on to someone else.  

• Export. Saves the current preset file to a location of your choice. 

Sharing a Custom Preset 
Any presets you make can be shared with other users, manually backed up to a new location, or 
copied to a new computer.  You can freely export your own presets and import another person’s 
presets into your application. 

1. To view any Custom presets simply chose File > Show Presets Folder….  Luminar presets 
have the file extension .lmp.   

2. Select the presets you want to share, then send them to fellow Luminar users. 
3. To copy presets on another machine, just choose File > Show Presets Folder… on the other 

computer. 
4. Simply drag the new presets into your Presets Folder. All presets in this folder appear in the 

Custom category and the All Presets category. 
5. For best results, restart Luminar to load all the new presets. 
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__________________________________________________ 

Note 
You can take precise control over your Custom presets with the Show Presets Folder… command. 

• To export, you can simply copy files from this folder. 
• To import, just copy the files into the new presets folder. 
• To delete a preset, you can simply delete the preset file in the folder. 

__________________________________________________ 

Adding a Custom Preset Pack 
Occasionally Skylum or other professional photographers will release a collection of presets, called 
“Packs”. When you import a Custom Preset Pack, it will create a new category in the Presets category 
window, and display any associated presets therein. 
To add a Custom Preset Pack, select the menu item File > Add Custom Presets Pack. An open 
dialog will be displayed, allowing you to choose the Pack you wish to add. 

You can also get more presets from the Category switcher.  Just click the Get More Presets… 
button. 

Page !  of !40 155



Using Workspaces 

Workspaces are an innovative way of working with your photos.  By using one of our built-in 
workspaces (or creating your own) Luminar can quickly adapt to the photo editing tasks at hand.  By 
tailoring which Filters are visible, you can speed up editing tasks with a guided workflow. 

What are 
Workspaces? 
Each workspace is a customized 
group of filters.  With the pre-
built workspaces these have 
been selected for specific types 
of photos.  You’ll find that using 
Luminar’s purpose-built 
workspaces offer uniquely 
tailored tools which achieve 
great results quickly.  

Changing Workspaces 
Switching between workspaces is easy, just click the Workspace drop-down menu at the top of the 
Filters controls. You’ll find six preset workspaces to make things easier 

• Clear Workspace. Removes any Filters from the image as a blank starting point. 

• Professional.  A robust set of filters for imaging professionals who want greater control over 
exposure, color, and details. 

• Quick & Awesome. Uses the speed of the Enhance AI filter for quick adjustments.  Also 
offers control for Saturation, Vibrance, and Clarity.  A good workspace for quick edits. 

• Essentials. A general set of recommended filters for most image types. 

• Aerial Photography. Designed for making drone photos look their best.  Easily overcome 
the challenge of small sensors and vibration to get crispy and colorful photos. 

• B & W. A set of controls well-suited for black and white conversion and contrast. 

• Landscape. A set of filters to enhance skies and foliage in a photo. 

• Portrait. A collection of filters well-suited to adjusting portraits of people. 

• Street. A workspace designed for enhancing gritty and urban imagery. 
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Saving a Custom Workspace 
Once you’re familiar with Luminar, you may find that there are certain filters you prefer working with.  
You can easily adapt a workspace to match just your 
needs. 

1. To start, click the Workspaces drop-down 
menu and choose Clear. 

2. Click the Add Filter button to browse all 
available Filters.  You can scroll through the list 
or click on a category to narrow your search. 

3. Continue adding Filters to the workspace that 
you’d like to use. 

4. When satisfied, click the Workspace pop-up 
menu and choose Save As New 
Workspace…. 

5. A dialog will pop-up at the top of the window 
asking you to name your workspace. Give it a 
descriptive name to help you remember which 
situations to use the workspace. 

If you ever need to modify a workspace, that’s easy too.  Just choose File > Show Workspaces 
Folder. 
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Setting a Default Workspaces 
If you’ve created a custom workspace that you want to 
use most often (or like a built-in workspace), you can 
easily set it as the new default. 

1. Choose a workspace that you’ve created or 
one of the built-in presets. 

2. Click the Workspace pop-up menu and 
choose Set as Default.  The next image you 
open (and all after that) will use this new 
workspace. 

3. Use the new default Workspace to quickly 
improve your images using your favorite filters. 
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Using Filters 

Filters are how you can adjust the exposure, color, contrast, and style of your image in Luminar.  The 
proper use of filters can significantly improve your image.  Each filter is designed to solve specific 
problems or enhance an image in a particular way. Be sure to click the Info (i button) in the Filters 
Catalog to see helpful descriptions. 

Applying a Filter 
In order to adjust an image in Luminar, you’ll need to apply a filter.  There are several ways to do this 
for an image.  You can choose the workflow that fits your personal style. 

• Use a Workspace. The six workspaces that ship with Luminar have suggested filters that you 
can use to adjust your images. Choose the workspace that best matches your style of 
photography from the Workspace pop-up menu. 

• Click the Add Filter Button. At the bottom of the Filters area is the Add Filter button.  You 
can also click the + button at the top of the Filters area. These both open a pop-up list of 
filters.  Use the Categories at the top to sort the list or the Search box at the top to look for a 
specific effect.  You can also over each name to see a description and sample image for each 
filter. 

• Add an Adjustment Layer. In the Layers area you can click the + button at the top and 
choose to add an Adjustment Layer.  Once added, the Effect list opens and you can apply a 
filter to its own layer.  This makes it easy to adjust the Blending Mode and Opacity for the 
Adjustment Layer to refine the look of the filter.  More on adjustment layers in the chapter 
“Working with Layers.” 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Single View Mode for Filters 
Working with several filters can get a little bit crowded (especially if working on a smaller screen like 
a laptop).  There is a useful mode to help you see just the filter you’re working with.  It’s called 
Single View mode and you can find it under the View menu. 

1. Make sure an image is open in Luminar. 
2. Click the Workspace menu and choose a Workspace such as Professional. 
3. Enable Single View mode by choosing View> Single View Mode.  

It’s active if there’s a checkbox next to its name. 
4. Now click on the disclosure triangle next to one filter’s controls and make an adjustment. 
5. Switch to another filter and click its disclosure triangle in order to edit.  

The previous controls should close and the new ones open. 
Single View Mode makes it easy to just see the controls you’re actively using in the side panel.  
Consider using this mode to reduce clutter on the screen. 
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An Overview Of Filters 
To help you get the most from Luminar’s filters, you’ll find a detailed guide that explains the major 
features of each.  Some filters have similar controls so you may notice that certain Filters have parts 
that perform similarly. Filters are grouped into different categories. based on function. All filters 
share some standard controls. At the top of each filter you’ll find: 

• Disclosure triangle. Click this triangle 
to hide or show a filter’s controls. 

• Filter name. Click the filters name to 
access a contextual menu of filter 
controls. 
 
 
 
 

 

• Filter mask button. The filter mask lets 
you paint with a brush to control where 
a filter’s results are shown or hidden. 

• Visibility icon. Click this icon to toggle 
the visibility for a filter’s results.  This is a 
useful way to judge the effect a filter is 
having on your image. 

At the bottom of each filter you’ll find: 
• Reset filter button. This resets all of the 

controls of a filter to their default value. 
You can also double-click an individual 
slider to reset a single controller. 

• Remove filter button. This removes the 
filter from the panel.  You can re-add a 
filter by clicking the Add Filters button 
at the top of the side panel. If you want 
to temporarily disable a filter, just click its visibility icon (the eyeball). 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Essential Filters 
The essential filter are some of the most frequently used in Luminar.  These filters perform core 
adjustments that are useful for most images. 

Accent AI Filter 
This filter automatically analyzes your image and instantly corrects it.  Under the hood, more than a 
dozen controls are in use.  This effect tends to yield naturally beautiful results with one simple slider.  
The Accent AI Filter can substitute for many traditional controls like shadows, highlights, contrast, 
tone, saturation, exposure, details and others. 

• Boost –  Controls the overall amount of the filter effect applied to your image.  

Page !  of !47 155



Black & White Conversion 
The B&W Conversion filter converts a color photo to black & white.  It also contains a number of 
controls to manipulate the monochrome look. 

• Color Filter. Six Color Filters are available which act similar to glass filters that are placed in 
front of a camera lens. Neutral, red, orange, yellow, green and blue. Each Color Filter when 
applied will brighten that specific color and darken the opposite color on the color 
spectrum. For example: Red is often used to brighten skin tones and Blue to darken skies. 
Click the Edit button to redefine any default value. 

• Luminance. Color sliders control the brightness of each relative color as it is converted from 
color to black and white. 

• Saturation. Each Color slider will introduce the respective color that was present within the 
original color image back into the black and white image. 

• Exposure. Controls the overall luminance value throughout the image. Adding exposure 
brightens the image while removing exposure darkens the image. 

• Contrast. Controls the differences in the relationships of tonal values. Adding contrast 
increases the difference between the highlights, midtones, and shadows. Removing contrast 
decreases the difference between these tonal values, “flattening” these relationships. 

• Highlights. Luminance control of the brighter values in the image, basically affecting the 
tones on the right side of the histogram independently from the darker values. 
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• Shadows. Luminance control of the darker values in the image, basically affects the tones on 
the left side of the histogram independently from the brighter values. 

• Whites. Very specific luminance control over the brightest values within the image, really 
only affecting the tones that lie within the far right of the histogram. 

• Blacks. Very specific luminance control over the darkest values within the image, really only 
affecting the tones that lie within the far left of the histogram. 

• Clarity. Allows users to increase the contrast in the midtones introducing more depth 
between the relationships of values that lie in the middle of the histogram. 

• Details. Increases image details globally or in highlights and shadows. 

Develop & Raw Develop 
The Develop and Raw Develop filter let you adjust the primary image.  This filter is usually run first.  
To learn more about it, see the section titled "How to Develop a RAW Photo.” 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Saturation/Vibrance  
This filter is a useful way to control the Intensity of colors in a photo.  It is often used in conjunction 
with Exposure or Tone adjustments. 

• Saturation. This slider adjusts the intensity of all colors in your photo.  

• Vibrance. This slider adjusts only the intensity of muted colors, ignoring well-saturated 
colors. This is useful for finer control when adjusting color. 
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Structure 
This tool allows adjusting of image detail and clarity. Using this tool you can get a classic HDR effect 
with great detail or get a smoother picture with less detail. This is the main tool to increase contrast 
of the image and visualize more details in the image. 

• Amount. The strength of the effect. By moving the slider to the right, the amount of visible 
detail in the image increases. Moving the slider to the left will cause the image to lose detail 
and flatten. The “zero state” in the middle means that the amount is not applied by default. 

• Softness. Controls the overall softness of structure and textures in the image. Moving the 
slider to the left will cause parts of the image to become less smooth and more unrealistic. 
This produces the so-called classic view of the HDR effect. Moving the slider to the right, on 
the contrary, the details become more global and the image is more realistic. This is very 
useful slider to adjust realistic details. 

• Boost. Adjusts the overall display of details. When moving the slider to the left, the images 
will become more realistic and “calm." Moving the slider to the right will accentuate details 
and make the image more unrealistic. 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Tone  
The Tone effect is a precise way to adjust overall brightness and contrast. It helps to provide tonal 
balance and a unique signature style to your photos. Tone is one of the most important filters to 
give your photos the necessary look.   This filter is similar to the Develop filter.  However you may 
have only one instance of the Develop filter in a recipe, you can have multiple instances of Tone. 

• Exposure. Adjusts the global luminance of the image. Moving this slider to the left results in 
a darker image (reduction of exposure value). Moving this slider to the right results in a 
brighter image (increase of exposure value). 

• Contrast. Adjusts the contrast of the image. Contrast is the difference in luminance or color 
that makes an object in an image distinguishable from another. Practically speaking, contrast 
is determined by the difference in the color and brightness of an object in relation to other 
objects within the same field of view. 

• Smart Tone. This slider adjusts the overall brightness of image properly. When moving to 
the right, the image is more vivid, but it does not work when bright areas become white, as 
in the ordinary exposure. And when you move the slider to the left, the image becomes 
darker but there are no completely black areas. This is a very powerful and balanced image 
brightness tool. 
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• Highlights. Adjusts the brightness of the brightest areas of the image. Moving the slider to 
the right cause very bright areas to become brighter, while moving the slider to the left, 
makes them darker. 

• Shadows. Adjusts the brightness level of the darkest areas of the image. Moving the slider 
to the right will cause such areas to become brighter and additional details will appear. 
When moving to the left, such areas become darker, and the number of shadow areas in the 
image generally increases.  

• Whites. Adjusts the white point of the histogram and white tones in the image. When 
moving to the right, the brightest tones will become brighter while the histogram stretches 
to the right. Moving the slider to the left will cause white tones in the image to become 
darker and the histogram to compress to the left. 

• Blacks. Sets the black point of the histogram or black tones in the image. Moving the slider 
to the right, black tones become brighter and the histogram compresses to the right. 
Moving the slider to the left, black become darker and the histogram stretches to the left. 

A recommended workflow is to start with a light touch with Exposure and Contrast, then Smart 
Tone. Then proceed to setting Shadows and Highlights and finally fine tune the contrast of the 
image using the Whites and Blacks sliders. 
__________________________________________________ 
Note 
Whites and Blacks can be used to fine-tune of contrast of the image. 
Strong raised Shadows can lead to a strong dark areas and loss of contrast.  
__________________________________________________ 
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Vignette 
A Vignette darkens or lightens the edges of your image. This is quite an old technique to emphasize 
the accents on photos. The effect typically leaves the central area unaffected while the edges are 
shaded or lightened. Luminar goes further by letting you place the center point of the vignette 
anywhere in the image you like. 

• Amount. Strengthens the darkening around the edges of photos. In position 0, the effect is 
not applied. Move the slider to the left side of the picture to give more shading to the edges, 
while moving the slider to right will brighten the edges. 

• Size. Size of the obscured area. Moving the slider to the left will increase the area of 
darkening. Moving the slider to the right will reduce the area of darkening. 

• Roundness. This slider changes the shape of the shaded area. 

• Feather. This slider sets the smoothness of the transition between the area of shading. 

• Inner Brightness. This slider increases the brightness in the central region which is not 
affected by shading. It allows you to create a contrast effect. 

__________________________________________________ 
Note 
This tool allows you to highlight key points in the photo, making it more interesting. A slight edges 
shading always provokes the viewer's eye to consider the lighter central part of the photo. For a 
realistic picture, don’t lower the Amount below -50. As a rule, this effect is used only with darker 
shading. Highlights are rarely used except for some vintage looks. 

__________________________________________________ 
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Issue Fixers Filters 
This set of filters is designed to solve image problems.  They are useful to enhance detail, sharpen 
an image or remove glare and unwanted color.  These filters can be useful to compensate for 
camera issues or challenges in the shooting environment. 

Clarity 
Adjusts the overall image clarity. By increasing the value of the slider, the number of visible details 
increases. If values are much larger, halos may appear on the contrast edges of the image. A best 
practice is to be careful when raising the value of the slider above 50. 

• Amount. Controls the amount of clarity added to the image. 
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Dehaze 
This filter provides a proprietary blend of contrast, clarity and color adjustments to help eliminate 
the effects of fog and haze often found in cityscapes, landscapes and aerial photos. It's especially 
helpful when editing photos shot through glass or if there is a lot of mist or fog in the scene. 

• Amount. Move this slider to the right to help cut though fog and haze.  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Denoise 
Upon close inspection, you may notice unwanted and distracting noise or grain in your digital 
image. Often, This is typically caused by shooting photos with a high ISO setting on a digital 
camera, but it can also be caused by underexposure or a long shutter speed. A lower-quality 
consumer camera is also more likely to exhibit noise problems. Fortunately Luminar offers an easy 
filter to reduce or remove noise. 

• Luminosity. Removes grayscale noise from an image. 

• Color. Removes color noise from an image. 

• Boost. Increases how aggressive the Denoise filter is. 
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Details Enhancer  
The Details Enhancer filter helps you create dramatic photos and brings crystal-clear sharpness to 
your images. With the proper detail enhancement, you can make your photos look great and sharp 
with no halos or extra artifacts.   

• Small Details. Small sets sharpness of fine details. At 0, the effect is not applied. Moving the 
slider to the right will intensify the clarity of small details, while moving to the left, on the 
contrary, will somewhat wash out the fine details. 

• Medium Details. This option sets medium-sized parts sharpness. At 0, the effect is not 
applied. Moving the slider to the right increases the sharpness, while moving the slider to 
the left decreases it. 

• Large Details.  Use this choice to set sharpness of global contours of objects in the image. 
At 0, the effect is not applied. Moving the slider to the right increases the sharpness, while 
moving to the left decreases it. 

• Highlight Protection. To ensure that the brighter areas of the image aren’t over-processed 
use the Highlight Protection slider. 

• Masking. Try the Masking slider to control the zone of detail amplification. When moving the 
slider to the left, the number of zones increases and the image becomes more detailed. 
When moving to the right, the number of granularity zones is reduced. Optimal masking 
comes from a setting in the range from 30 to 70. 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Foliage Enhancer   
Enhances the colors of foliage and greenery automatically, making them more vivid and natural. A 
good choice for nature and lush landscape images. 

• Hue. Modifies the hue of the affected foliage.  Useful to dial in the right amount of green. 

• Amount.  This controls how strong the adjustment is for the image. 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Polarizing Filter  
On a camera, a polarizing filter can provide more color depth and cuts atmospheric haze, resulting 
in richer, bluer skies. The same holds true with the Polarizing Filter in Luminar.   The effect will 
produce deeper blue skies and more contrast in clouds. With a light touch of this filter, almost any 
landscape image can be improved.   

__________________________________________________ 
Note 
It is not recommended to use this tool on night photos or images with no sky in them. Most times, 
keeping the effect intensity under +50 will yield the best results. 

__________________________________________________ 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Remove Color Cast 
Automatically removes undesirable color casts in your images by detecting and adjusting the hue. 
You can also make manual adjustments to fine tune the result. 

• Method.  There are three methods to choose from.  Two are automatic that attempt to 
determine color cast.  The other lets you manually adjust the Hue. 

• Amount. This slider is the amount of correction. 

• Color.  Adds color back to the image that cab be used to correct color cast.  If overdone, a 
new cast is added. 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Sharpening 
The Sharpening Filter helps focus soft edges in a photo to increase clarity or focus. Use this tool to 
significantly improve image quality. Keep in mind that too much sharpening can give your photo a 
grainy look. Please note: on most screens sharpening results can be seen at 100% or more Zoom. 

• Amount. Effect of the micro sharpness applied to the image. 

• Radius. Distance away from contrast edges that the effect is applied. 

• Masking. The dynamic masking feature allows you to reveal details only in appropriate areas 
and can help you define the sharpness in your image.  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Creative Filters 
The Creative Filters are designed to unlock mood or emotion in an image.  A wide range of choices 
can be used as individual filters or in combination to create new looks. 

Brilliance/Warmth 
Use the Brilliance/Warmth filter to a. dd rich color and warmth to any scene. The filter offers very 
responsive controls which makes it easy to use. Positive values can be used to warm the image.  Plus 
you can use negative values to tone down an image as well. 

• Vividness. Useful for creating rich color in a photo. 

• Warmth. This controls the color temperature in the image. It can be used to stylize an image 
or correct a color balance issue. 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Сross Processing 
Reproduces a color cross-processing effect once commonly used in developing film to create 
unnatural color and interesting contrast shifts. 

• Type. Using the drop down list to choose a color palette preset inspired by various 
international cities. 

• Amount. Drag the amount slider to affect how strong the cross processing effect is.  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Dramatic 
The Dramatic filter is a creative filter that lowers saturation and increases contrast, helping to 
achieve a gritty cinematic look in your photos, similar to the darkroom technique “Bleach Bypass.” It 
is often used in stylized fashion shoots, urban images, or grungy athletic portraits. 

• Amount. The Amount slider controls the total intensity of the added effect. 

• Contrast. Controls the differences in the relationships of tonal values. Adding contrast 
increases the difference between the highlights, midtones, and shadows. 

• Local Contrast. Adds a more targeted contrast adjustment to the finer details of the image. 

• Brightness. Darkens or lightens details in the image.  Often useful for bringing out details in 
areas like skies. 

• Saturation.  Controls whether colors become washed out or more saturated.  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Fog 
Allows you to add a strong softening or blurring effect to part of your photo, simulating the high 
humidity weather phenomenon commonly known as “Fog”. You can add Light Fog or Dark Fog to 
an image and adjust its intensity with the Amount slider. 

• Fog Type. Choose from two different style of fog. 

• Amount. Controls the amount of fog added. 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Golden Hour 
Use the Golden Hour filter to bring warmth, softness, and golden glow to all of your photos. Simply 
dial in the amount of warm toning using the Amount slider and use the Saturation slider to 
introduce an even more overall color vibrancy. Quickly emulate the magic that happens just after 
sunrise or just before sunset. 

• Amount. This controls the amount of warm toning. 

• Saturation. This controls the overall saturation of the Golden Hour filter.  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Grain 
Emulates the structure of analog film stock by introducing a random, stylized grain into your image. 
Keep in mind that grain and photo noise are different things. Use grain to give your color and black 
& white photos a cool analog feel.  

• Amount. This controls how present the grain is. 

• Size. This adjusts the size of the grain being added. 

• Roughness. This affects the visual appearance of the grain. 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High Key 
Emulates the look of a high key lighting set-up where the main light source slightly overexposes the 
subject. This produces bright high contrast images. Often used in Fashion & Beauty photography.  

• Amount. How much of the effect is added to the image. 

• Glow. Controls the behavior of the brighter areas of a photo. 

• Standard High Key. Affects the image in a global fashion. 

• Dynamic High Key. Is more limited in its effect, taking skin tones into account as it applies 
the filter to the image. 

• Saturation. Determines if the overall colors become washed-out or stay richly-saturated. 

• Black. Maintains contrast in the darkest areas. 

• Contrast. Impacts the overall contrast in the image (the relative difference between the 
lightest and darkest areas). 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Hue Shift 
This filter lets you roll the hue in a photo for subtle or dramatic changes.  A little is perfect to 
eliminate unwanted color tints while a big adjustment is perfect for dramatic style. 

• Hue. This slider controls the Hue of the overall image. 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Image Radiance 
This filter provides for an overall “dreamy” look to your image by softening image luminescence, 
and increasing contrast & saturation. It can create a dreamy, fantasy look for photos by increasing 
contrast and adding a creative glow, prioritized to the lighter areas of the image. 

• Amount. The overall effect strength. For a moderate effect and a more realistic image, keep 
the values in the Amount to +40. If the Amount value is 0, then the effect is not applied. 
Move the slider to the right to increase Amount. 

• Smoothness. This controls the softness of the effect. 

• Brightness. Use this slider to control the brightness of the effect. 

• Shadows. Adjusts the black point for the darker areas of the image. 

• Saturation. A useful way to adjust the color saturation of the effect applied to the image. 

• Warmth. Adjusts the hue of the effect towards the warm end of the scale. 

__________________________________________________ 

Note 
At a low setting, this effect will give the image more contrast and can increase color in the image. 
Use the Smart Colorize slider for better control. 

__________________________________________________ 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Matte Look 
This filter can give your photos an aged look with flat color and high contrast.  This works well for 
both landscape and portraits to change the emotion of your image. 

• Amount. The overall strength of the matte look effect. 

• Fade. Controls the loss of detail that happens in the darker areas of the image. 

• Contrast. This adjusts the relationship between the brighter and darker areas of the filter. 

• Vividness. This control can be used to affect how richly saturated the effect is. 

• Toning Range.  Affects what portion of the image has its color shifted. 

• Toning Hue. This sets the color that the image takes on. 

• Toning Saturation. This controls how strong the toning effect is.  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Orton Effect 
The Orton Effect allows enhancements to an image that includes glow and focus which produces 
photos that are sharp and blurry at the same time. This is a great way to add a unique look to your 
photos. 

• Type: They Type pop-up menu offers two choices.  Type 1 increases the Saturation of the 
image while Type 2 is a softer glow. 

• Amount. Controls the overall strength of the effect. 

• Softness.  Choose whether you want the effect to blend gently or have more defined edges. 

• Brightness.  This control can raise the luminance values of the entire image. 

• Contrast. Use this to maintain a crisper difference between the light and dark areas of the 
photo.  This is a useful way to create rich blacks and bright whites. 

• Saturation.  Controls the intensity of colors in the affected image. 
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Soft Focus 
This filter emulates a soft focus lens effect or diffusion material placed across your lens.  It is perfect 
for adding a creative glow to portrait and wedding photos. 

• Type. Use the pop-up menu to choose from two styles of an effect. 

• Amount. The Amount slider controls the intensity of the Soft Focus filter. 

• Brightness.  Use this slider to increase the relative exposure of the photo. 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Soft Glow   
This effect us useful for creating a lighting effect in photos.  It is especially useful for bright areas in 
your image such as streetlights or sky. 

• Amount. The overall effect strength. If the Amount value is 0, then the effect is not applied. 
Move the slider to the right to increase Amount. 

• Smoothness. This controls the softness of the effect. A Higher value creates a gentler blend 
between the affected and unaffected areas of the image. 

• Brightness. Use this slider to control the brightness of the effect. 

• Warmth. Adjusts the hue of the effect towards the warm end of the scale.  
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Split Toning 
A powerful creative tool, Split Toning offers the ability to introduce color toning to black and white 
images. Toning a black and white image can transform the mood of the resulting image and also 
help in some printing processes. 

• Amount. The overall strength of color toning applied to an image. 

• Highlights Hue. Scroll through a spectrum of colors to choose the toning of the bright 
values in a scene. 

• Highlights Saturation. This increase the intensity of the color in the light area of the image.  
Protection - Preserves white in the brightest highlights in an image.  
Shadows. 

• Shadow Hue. Scroll through a spectrum of colors to choose the toning of the darker values. 

• Shadow Saturation. Increase the intensity of the color in the dark areas of the image. 

• Balance. Shifts the balance between what is considered and affected by the Highlights 
adjustments and the Shadows adjustments of Split Toning. Slide to the left and the 
adjustments made to the Shadows will take precedent, slide to the right, the adjustments 
made to the Highlights will take precedent. 
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Sun Rays 
Add a whole new light source to your photo, the sun!  You can control its position, the warmth, and 
amount of glow for a subtle or even dramatic change in lighting. Combine the filter with blending 
modes for even more control to your lighting. 

• Place Sun Center. Click this button to interactively nudge the sun’s position by dragging. 

• X. Moves the sun’s origin point along the X-axis. 

• Y. Moves the sun’s origin point along the Y-axis. 

• Sunrays Amount. Controls the overall intensity of the sun rays. 
Sunrays Look.  This changes the overall brightness of the scene; 

• Sunrays Number.  Use a higher number for more rays and a lower number for fewer. 

• Sunrays Length. This impact the distance the sun rays will travel.                                                                                      

• Sunrays Warmth. Use this slider to adjust the color temperature of the rays. 

• Sun Radius. This affects the size of the sun rays origin point. 

• Sun Glow Radius. This slider changes the size of the glow around the sun. 

• Sun Warmth. Can change the sun from bright white to a warm glow.                                                                                                

• Overall Penetration. This slider impacts how much the sun passes through an area.  This 
can be useful when trying to natural composite the rays into a photo.                                                                                                                               

• Overall Randomize. Use this slider to get entirely new results that are a variation based on 
the current settings. 
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Texture Overlay 
Enables custom images and textures to be blended as a layer into the current image. Textures can 
easily give your photos new unique looks, especially when you’re trying to achieve a vintage or 
grungy look.   

• Load Texture. Click the Select Texture button to open a file browser.  You’ll be able to 
choose a texture graphic on your hard drive. 

• Flip/Flop buttons. This swaps the direction if the texture image. 

• Amount.  Use the Amount slider to control how the image lightens or darkens based upon 
the texture layer. 

• Zoom. Controls the size of the texture. 

• Blend Mode. Use a Blending Mode to change how the texture mixes with your image.   
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Professional Filters 
For complete control over your image, professional filters allow fo precise adjustments.   This filters 
offer more control for fine adjustments in an image. 

Advanced Contrast 
Precisely adjusts tonal contrast with six distinct controls spanning highlights, midtones and 
shadows, making for more detailed results.  

1. Use the Highlights, Midtones, and Shadows sliders to refine the amount of contrast in each 
zone. Dragging to the right increases contrast. 

2. Use the three Balance sliders to define the midpoint for each zone.  This allows you to refine 
which area is treated as a Shadow, Midtone, and Highlight. 
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Channel Mixer  
Digital images are comprised of Red, Green, and Blue information.  These components are called 
channels and if they are not balanced properly an image can show color casts.  By modifying 
channels you can choose to emphasize or deemphasize certain details.  The Channel Mixer filter 
allows fine-tuning adjustments and mixing of the Red, Green and Blue color channels (RGB) to 
create highly customized images.  Many users will also use the effect in combination with their black 
& white conversions workflows.  

• Red/Green/Blue. Use the tabs to switch between each color channel. 

• Red. Influences the balance of Red details. 

• Green. Influences the balance of Green details. 

• Blue. Influences the balance of Blue details. 

• Constant. Adds a global amount of influence to the entire channel. 

__________________________________________________ 
TIP 
If you press and hold the Option key and click on a slider value in the sidebar, moving the cursor to 
the left and right will let you set the values of the slider with high accuracy. Slider sensitivity is higher 
than with its normal movement. This allows you to fine-tune to small numeric values. 
__________________________________________________ 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Сolor Balance 
The Color Balance filter is useful to change the overall mixture of colors in an image for general 
color correction. It can also be used for creative control within different tonal regions of an image. 

• Tone. Choose the region to adjust.  You can select Shadows, Midtones, and Highlights. 

• Color Balance Sliders. Adjust the balance of Cyan-Red, Magenta-Green, and Yellow-Blue to 
emphasize certain colors in each tonal region. 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Color Contrast 
This filter lets you choose a color range to which to apply contrast. The color selected will cause 
objects of that color to become lighter, while opposite colors on color wheel will become darker. 
This effect can help make flat images pop based on the colors in the image. 

• Amount. This controls contrast that is created between differences based on colors (vs. 
luminance). The strongest is the more contrast between primary and secondary colors. 

• Hue. Chooses the target Hue for emphasis. 

• Brightness. The overall lightness or darkness of the image is controlled with this slider. 

• Contrast. This slider emphasizes the difference in brightness between areas and objects 

__________________________________________________ 
TIP 
Double click on any slider name resets the value to the default. In most cases, double-clicking 
returns it to 0. 
__________________________________________________ 
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Сurves 
One of the most powerful tools for adjusting tones to brighten, darken, add contrast and shift 
colors. Curves can usually be applied to all channels together in an image, or to each channel 
individually. Curves can help you manually fine-tune the brightness and contrast of the image. 
Most users will either use Curves a lot or they won’t use it at all. The Curves interface is a bit 
complex and allows for up to 10 control points. This can significantly open up more options when 
adjusting color and exposure. The primary advantage of Curves is that you have precise control 
over which points get mapped for tonal adjustment. 

• Tabs. You can make a curve adjustment to all channels equally or to an individual channel 
(such as to blue to emphasize the sky). 

• Sliders. At the bottom there are sliders that let you adjust black and white points of the 
histogram (the leftmost and rightmost sliders), as well as the middle bend of the curve (the 
central slider). 

• Points. You can add up to 10 control points.  Drag up to add contrast to an area and down to 
lighten the area. Multiple points can be employed for contrast adjustments based on tonal 
range. 
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Dodge & Burn 
Dodge & Burn tools are known as toning tools. They allow for finer control over lightening or 
darkening an image. These tools simulate traditional techniques used by photographers. In a 
darkroom, the photographer would regulate the amount of light on a particular area of a print.   

1. To Dodge and Burn, apply the Dodge & Burn filter in the Filters list. 

2. Click the Start Painting button to open up your canvas. 

3. Choose either the Lighten or Darken tools in the top Toolbar to select the desired brush. 

4. Use the Size slider in the Toolbar to control how large the brush is. 

5. Use the Strength slider to control its impact. 

6. If you get an accidental stroke, the Erase tool can be used to remove it. 

7. Click Reset if you need to start over. 

8. Click Done to apply the adjustment. 

9. Use the Amount slider in the filter control group to further refine the global intensity of 
the filter and blend it back with the original image. 

__________________________________________________ 
NOTE 
This is a tool that is meant to be used creatively and by feeling.  It is more about the looks and results 
than it is specific numbers and sliders. Feel free to experiment as you can always adjust the mask of 
the Dodge & Burn effect as well as its overall opacity. 
__________________________________________________ 

Page !  of !84 155



HSL  
Selectively adjusts Hue (color), Saturation (color purity), and Luminance (intensity) of individual 
colors in the image for color correction to balance tones and explore creative possibilities. Allows 
you to create unique looks with selective coloring. 

There are 3 tabs present in the Color Filter panel. 
• Hue. A set of sliders to adjust the hue or basic color shades of your image. Sliding the 

control further to the right results in a shift towards the next color in the list (for example 
from Orange to Yellow). Sliding the left shifts the hue towards the previous color in the list 
(for example from Orange to Red). 

• Saturation. A set of sliders to adjust color saturation. Sliding the control further to the right 
results in a more intense color. Of course, moving to the left removes color to the point 
where -100 will make the image appear black and white. 

• Luminance. A set of sliders to adjust the brightness of the colors. Sliding the control further 
to the right results in a brighter color within the image. The further to the left, the darker the 
image. 
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__________________________________________________ 
Note 
This is a powerful tool for fine-tuning of colors in the image as well as a means for creative image 
processing. Examples of using this tool: 

• The sky is mostly blue in photos. Therefore, lowering the brightness of blue colors in the 
image can cause more dark and deep blue of the sky. 

• Reducing the tone for some colors (move the slider to the right in Saturation tab), and leaving 
it for the other can cause a dramatic effect on the selective color in photos. 

• Raising the yellow color (move of the slider to the right) can significantly improve color 
saturation of autumn foliage on the photos. 

__________________________________________________ 
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LUT Mapping 
Use professional lookup tables to change the appearance of your photo quickly.  Choose from film 
stocks, black and white looks, and create color grades to unlock a new style in seconds. You’ll find 
several built-in stylize in the pop-up list, you can also load your own lookup tables in the .cube 
format. 

• Amount. This lets you reduce the intensity of the Lookup Table. 

• Contrast. This impacts the overall contrast in the image and can be used to refine the LUT’s 
appearance. 

• Saturation. This impacts the overall saturation in the image and can also be used to refine 
the LUT’s appearance. 

__________________________________________________ 
Note 
If you choose a custom LUT it will automatically be stored with your saved Luminar file or 
embedded into any custom preset that you create. 

__________________________________________________ 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Microstructure  
Improves the sharpening of your image in small areas of fine detail and texture. Advanced 
parameters allow you to fine tune this subtle yet dramatic effect. Use this tool to get some creative, 
HDR-like effects.  

• Amount. Use the Amount slider to control how much structure is added.  

• Smoothness.  Try the Smoothness slider to better blend the increased details and avoid 
hard edges. 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Photo Filter  
This filter simulates color filters that traditionally are attached to a camera lens.  Professional 
photographers often place glass filters in front of the camera lens to “cool” or “warm” a picture, or 
to add special effects. These can also be used to accentuate complementary colors, and add 
creative toning to your photos. 

• Amount. Controls how much of the colored filter is added to the image. 

• Hue. Sets the color value for the photo filter. 

• Saturation. Controls the intensity of the color added to the image. 

• Save Luminosity. This option prevents the overall exposure of the image from changing.  It 
is useful for most cases and should be turned on to compare its effect. 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Split Color Warmth  
This filter can be used to selectively enhances cool and warm tones in your image. Allows you to get 
increased color contrast and vibrancy or create creative toning effects. You can separately adjust the 
Warm Colors and Cool Colors.  Drag to the left to reduce Saturation in a target and to the right to 
add more in. 
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Utility 
These filters are designed for making functional changes to an image.  They are often useful for 
adjusting the lighting in an image, or tone. 

Adjustable Gradient  
The Adjustable Gradient  filter allows you to selectively adjust exposure, contrast, vibrance and 
warmth for 2 different parts of the image. You can adjust the mask orientation for selective 
adjustments. This effect is very well-suited for adjusting the sky and ground regions in a photo. 

• Set Orientation – Use intuitive on-screen controls to adjust the blending of the top and 
bottom area. 

• Exposure –  Adjusts the luminance of the image. Moving a slider to the left results in a 
darker image (reduction of exposure value). Moving this slider to the right results in a 
brighter image (increase of exposure value). You can adjust the relative exposure for both 
the top and bottom of the image independently to refine an image. 

• Contrast – Separate contrast controls allow you to modify the amount of  contrast at the top 
and bottom of the image.  Contrast is the difference in luminance or color that makes an 
object in an image distinguishable from another. Practically speaking, contrast is determined 
by the difference in the color and brightness of an object in relation to other objects within 
the same field of view. 
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• Vibrance. This slider is a "Smart Saturation” control. In general, its effect is similar to 
Saturation with the difference that it increases less vibrant colors stronger and has a weaker 
effect on more vibrant colors. This allows you to get more realistic and less saturated colors 
the picture. This slider can be used in conjunction with the Saturation to enhance the 
secondary colors. 

• Warmth. This slider affects how warm or cool an image appears.  A positive value adds 
warmth while a negative value cools the image.  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Bi-Color Toning 
This filter simulates a traditional glass bi-color filter.  It uses two colors and a soft transition to tone 
the image. This is a good choice for enhancing seascapes and landscape photos. 

• Amount. This controls the intensity of the filter.  Overall, how strong the colors are.  

• Top Color. This is the color used at the top of the frame.  This will usually be a shad of blue 
or purple for the sky. 

• Bottom Color. Use this color to control the landscape or water color. 

• Blend. The blend control affects how smooth or a transition there is between the top and 
bottom adjustment.  A higher value creates a soft transition while a lower value is more 
abrupt. 

• Shift. The shift option moves the transition point between adjustments.  By default it is 
centered top-to-bottom, but this can be raised or lowered in the frame. 

• Rotation. If your image is angled (or your scene has strong geometric composition) you can 
rotate the angle of the blending.  You’ll find controls to rotate + or - 90˚. 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Brightness/Contrast 
This is a basic filter which adjusts the overall lightness or darkness of an image (brightness) and the 
difference in brightness between areas and objects (contrast).  This filter is easy to understand and 
works well for new users. For best results consider using the Tone or Develop filters. 
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Color Temperature 
This filter modifies the color temperature of the photo, making it cooler (more blue) or warmer 
(more orange). It helps you fix incorrect color temperature on your photos. 

• White Balance. Use the White Balance preset list to choose from a variety of presets that are 
similar to a camera’s white balance menu. 

• Temperature. Use this slider to warm or cool a shot.  This adjustment essentially adds Cyan 
or Yellow to an image to change its color temperature. 

• Tint. This adjusts the amount of Green or Magenta that is added to a shot.  It is useful for 
removing color casts from an image. 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Exposure 
A simple filter to adjust the overall Exposure of the image. This filter only offers one slider.  For more 
control consider using the Tone or Develop filters. 
After adjusting the Exposure filter you may need to use a Saturation/Vibrance filter.  Increasing 
exposure will desaturate the image.  Decreasing exposure will boost the saturation. 
This filter works well with filter masks for precise adjustments to exposure. 
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Highlights/Shadows 
Provides adjustment for highlight and shadow by changing the brightness of each region 
independently. You’ll often need to combine this filter with a Saturation/Vibrance adjustment to 
restore washed-out color in recovered areas. 

• Highlights . Adjusts the brightness of the brightest areas of the image. Moving the slider to 
the right cause very bright areas to become brighter, while moving the slider to the left, 
makes them darker. 

• Shadows. Adjusts the brightness level of the darkest areas of the image. Moving the slider 
to the right will cause such areas to become brighter and additional details will appear. 
When moving to the left, such areas become darker, and the number of shadow areas in the 
image generally increases. 

Page !  of !97 155



Top & Bottom Lighting  
This filter allows selective adjustment of lighting for the top and bottom parts of the image. Controls 
permit shifting the transition area, rotation angle and blending gradient. This effect is widely used in 
landscape or architecture photography with a distinct horizon. The effect flexibly and separately 
controls the brightness and other aspects of the top and bottom of the image.  This enables you, for 
example, to lower the brightness of the sky and raise the brightness of the foreground. Thus, your 
image can be significantly improved without resorting to creating layers and masking. 

• Set Orientation. Click this button to adjust the area affected by the filter.    You can drag the 
on-screen controls to identify the Top and bottom areas. 

• Top. Controls the brightness of the top of the image. Moving the slider to the left will make it 
darker and to the right brighter. 

• Bottom. Controls the brightness of the bottom of the image. Moving the slider to the left will 
make it darker and to the right brighter. 
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Whites/Blacks 
This filter is a simple way to adjust the white and black point of an image.  This gives you finer 
control over the contrast in a photo.  Drag a slider to the right to brighten a zone and to the left to 
darken. 

• Whites. This affects the brightest areas of the image. 

• Blacks. This affects the darkest areas of the image. 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Using Blending Modes with Filters 
The use of filters can be significantly extended with blending modes.  Each filter supports the use of 
its own blending mode, which allows for very complex combinations of results. Blending modes are 
both a mystery and a source of great design power. Each blending mode controls how a filter’s 
results are blended with the image below. 

Applying a Blending Mode to a Filter 
To access Blending Modes for a filter 

1. Apply a filter to an image. 
2. Click the triangle next to a filter’s name. 
3. From the drop-down menu choose Blending Mode. 
4. Select a blending mode from the list. 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Definition of Blending Modes  
How do blending modes work? The simple answer is, it depends. Your response is likely, depends 
on what? Simply put, the effect achieved by blending a filter varies with the contents of the original 
layer and the filters applied. A blending mode compares the content of two and enacts changes 
based on the content of both. 

Here are the modes supported by Luminar: 

• Normal. The default mode performs no additional change to 
how layer contents interact. 

• Darken. Pixels lighter than blend are replaced; darker ones are 
not. 

• Multiply. Is similar to drawing strokes on the image with 
markers. The colors of the top layer or blended with the image. 

• Color Burn. Evaluates each channel; darkens base by 
increasing contrast. 

• Lighten. Evaluates each channel; it then uses base or blend 
color (whichever is lighter). 

• Screen. Uses a lighter color. It is useful for “knocking” black out 
of a layer. 

• Overlay. Overlays existing pixels while preserving highlights 
and shadows of base. 

• Soft Light. The effect is similar to shining a diffused spotlight on 
the image. 

• Hard Light. Effect is similar to shining a harsh spotlight on the 
image. 

• Difference. Evaluates each channel and subtracts or inverts depending on brightness. 

• Subtract. Looks at the color in each channel and subtracts the blend from the base.  

• Hue. Uses luminance and saturation of the base and the hue of the blend. 

• Color. Preserves gray levels. It’s very useful for coloring and tinting. 

• Luminosity. Is the inverse effect from the Color mode. 
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__________________________________________________ 
Note 
To get the most from blending modes: 

• Experiment Freely. The best way to use blending modes is to just try them out. 
• Exploit Blending Modes. Do you need to tint an image? Place a Photo Filter on top of the 

image and change to Hue or Color mode. Need to drop out white in a layer? Just set it to 
Multiply mode. Blending modes are available for every filter. 

__________________________________________________ 

Additional Filter Controls 
If you’d like to take additional control over how filters behave, try these two advanced options. 

• Double click a Slider. If you double-click on any slider name resets the value to the default. 
In most cases, double-clicking returns it to 0. 

• Hold the Option Key. If you press and hold the Option key and click on a slider value in the 
sidebar, moving the cursor to the left and right will let you set the values of the slider with 
high accuracy. Slider sensitivity is higher than with its normal movement. This allows you to 
fine-tune to small numeric values. 

• Masking. Click the mask button next to a filter’s name to control how a mask is applied. See 
the section “Masking Options in Luminar” to learn more. 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Working with Layers 

Each layer can contain discrete elements of your project. Layers can contain photos, textures, ore 
adjustments. There are lots of ways to create and manage layers, but it all comes back to having an 
organized design. Be sure to double-click on the name of each layer and give it a clear, descriptive 
name to make your workflow easier. 

Using Layers 
To make sure Layers are visible, do the 
following. 

1. Launch Luminar and open an image. 
2. If Layers aren’t visible, click the Side 

Panel button in the Top Toolbar to 
open the panel.  You can also press 
the Tab key to open the Side Panel if 
it’s hidden 

3. If Layers still aren’t seen, click the 
Layers button in the Top Toolbar to 
view Layers.  

4. Review the Layers panel. When you 
first open an image, it’s named with 
the original name of the file.   

This base layer can have filters applied directly to it or you can add more layers above.  Each new 
layer uses the previous layer below as its starting point. In other words, each layer imposes the 
result of its processing on the previous layer. 

5. To add another layer, click the + button at the top of the Layers controls.  You can either add 
an Adjustment layer or an Image layer. 
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Using an Adjustment Layer 
Luminar offers a special type of layer that makes it easy to precisely edit your photos.  Any filter or 
filters in Luminar can be applied to an Adjustment Layer.  This is a really flexible way to work with 
you photos as it means you can easily control advanced options for filters such as their application 
order, opacity, or blending modes.  Adjustment layers give you the most flexibility when editing a 
photo. 
Here’s how to work with Adjustment Layers. 

1. Open an image within Luminar. 
2. If hidden, open the Layers panel. 
3. At the top of the Filters 

section click the + 
button. 

4. Choose the item Add 
New Adjustment 
Layer. 

5. From the Add Filters 
list, choose a filter to 
attach to the 
adjustment layer.  
Alternatively you can 
apply a Workspace to an adjustment layer. 
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6. To make things easier, be sure to give the new 
adjustment layer a descriptive name. 

7. Adjust the filter’s results to taste. 
8. Use advanced controls to refine the look of the filter 

such as the layer’s blending mode and opacity 
settings. 

9. Continue to add additional effects as needed to their 
own adjustment layers. 

10. As needed, you can turn layers on or off to alter the 
image’s appearance.  You can also drag adjustment 
layers up or down in the layer stack to generate new 
effects. 
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Using the Add New Image Layer Command 
The Add Image command is a useful way to add one image on top of another in a Luminar project.  
There are many possible reasons to do this, including design and technical. In this chapter we’ll 
explore four uses for this effect 

Loading a Texture Layer 
The use of texture layers is quite a useful way to stylize an image.  You can use the Add Image 
command to place a texture above a photo. 

1. Click the + symbol at the top of the Layers panel 
and choose Add New Image Layer…. 

2. Navigate to a texture layer on your hard drive and 
click the Open button to add the file to your 
document.  The layer is automatically named with 
the filename of the selected file. 

3. To scale the texture, right-click on its thumbnail 
and choose Image Mapping. 

4. Select one of the three mapping options.  You can 
Fit the image to the width or height, Scale to Fit 
to enlarge the image to fit the screen, or use Fill 
to distort the image to fill the screen. 

5. Click the Blend menu to change the Blending 
mode for the Texture layer. 

6. Drag the Opacity slider to refine the blending of 
the two layers. 
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Remember, a texture must be an external file. As you adjust the blend mode and opacity of the 
texture layer, it will create many different creative effects. Each mode will have a different impact on 
your image based on the type and opacity you choose. Adding a texture to your image can 
dramatically change the look and feel of your work, plus you may want to use a brush to apply the 
texture only in specific areas of your image. 
__________________________________________________ 
Note 
Textures are not stored in Luminar. These files are located wherever you’ve saved them for usage. For 
easy access, we recommend keeping all of your textures in a consistent place on your hard disk. 

__________________________________________________ 

Adding a Watermark or Logo 
A logo or watermark is an excellent way to brand an image before you post it to the Internet or 
make a print. You can use the Add Image command to place a watermark or logo above a photo. 
Let’s learn how you can load a photograph or scan of a signature.  In this example, the image is 
black text on a white background. 

1. Click the + symbol at the top of the Layers panel and choose Add New Image Layer…. 
2. Navigate to a logo or watermark on your hard drive and click the Open button to add the file 

to your document.  The layer is automatically named with the filename of the selected file. 
3. To scale the texture, right-click on its thumbnail and choose Image Mapping. 
4. To prevent unwanted distortion of the watermark or logo, choose Fit.  
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5. Let’s turn the logo to white text over a black background.  We’ll do this by applying a Curves 
filter to the logo layer. 

6. Invert the curve by reversing the white and black points. 

7. To scale the watermark, click the Free Transform Tool or press Cmd + T. 
8. Click the Lock icon in the Info Bar to prevent unwanted distortion. 

9. Drag a corner handle to resize the logo.  Drag in the center to position.  Resize and position 
the logo to taste. 
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10. Click the Done button when satisfied to position to logo. 
11. You can also experiment with different blending modes to remove the background color.  

For example you can use screen to remove a black background and multiply to remove a 
white background. 
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Replacing a Sky 
A professional photographer can spend a good part of a day waiting for the perfect sky and 
weather conditions. Sometimes though, no matter how patient you are, skies will often be washed 
out and appear missing due to overexposure. One solution is to take pictures of the sky when it 
looks its best, and then use a few techniques to combine two or more images into a new 
composited photo. 
These technique can be done using Layers, along with the Gradient Mask and Transform tools. 

1. Open a photo that needs a new sky. Use any filters needed to enhance the image to better 
match the style with the sky you’ll add. 

2. Click the + symbol at the top of the Layers panel and choose Add New Image Layer.... 
3. Navigate to a sky image on your hard drive and click the Open button to add the file to your 

document. The layer is automatically named with the filename of the selected file. 
4. Once the file is opened, it will obscure the layer below it.  
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5. To add back the sky image, one technique is to apply a Gradient Mask, which will have the 
effect of pulling back in the sky with more emphasis on the upper part of the image.  

6. Resize or move the gradient as needed for a best fit and click the Done button to apply it. 
7. Sometimes the horizon line can be slightly harsh, so to tackle that by clicking on the 

Transform tool. Move the bottom handle to re-position the sky more to your liking. 

8. You can also touch up edges of the Gradient Mask using a brush with decreased exposure 
and set to a low Opacity such as 20%. Brush over any areas that need additional blending.  

__________________________________________________ 
Note 
The desert or the ocean is the best place to shoot the sky. This is often because the amount of 
environmental and light pollution is greatly reduced and you often have a strong horizon line. Don’t 
worry; just keep your eyes out for a great day with beautiful skies and remember to shoot them. 
__________________________________________________  
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Creating a Stamped Layer 
As you work with layered photos, you may decide that you want to create a merged copy of those 
layers.  Perhaps its to apply additional effects, or maybe to mask and blend the layers together.  
Luminar calls this feature a stamped layer, and it simply means that all of the current layers and 
filters combine to a new layer at the top of the Layers panel. 
Here’s how to create a stamped layer. 

1. Open an image within Luminar. 
2. If hidden, open the Layers panel. 
3. Design using Adjustment and Image layers as 

you wish. 
4. When ready to merge layers, click the + button 

at the top of the Layers’ section and choose 
Create New Stamped Layer. 

5. The new layer based on all the others is at the top of the Layer stack.  Feel free to use 
options like masks, blending modes, or additional filters to process.  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Using Blending Modes with Layers 
A blending mode compares the content of two layers and enacts changes based on the content of 
both. You can choose from 14 different blending modes using the pop-up menu at the top of the 
Layers controls.  Understanding blending modes requires a bit of science.  To start let’s establish 
three key terms. 

• Base color. The original color in the image 

• Blend color. The color being applied by the top layer or Adjustment layer. 

• Result color. The color resulting from the blend 

To adjust a layer’s Blending Mode is easy. 
1. Open a photo within Luminar. 
2. In the Layers controls click the + button and choose the Add New Image Layer option. 
3. For the top layer, click the Blend pop-up menu in the Layers control area.  

4. Choose from one of the 14 available blending modes. 
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Normal.  
The default mode performs no additional change to how layer contents interact. 

Darken.  
Pixels lighter than blend are replaced; darker ones are not. 
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Multiply. 
Is similar to drawing strokes on the image with markers. The colors of the top layer or blended with 
the image. 

Color Burn 
Evaluates each channel; darkens base by increasing contrast. 
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Lighten 
Evaluates each channel; it then uses base or blend color (whichever is lighter). 

Screen 
Uses a lighter color. It is useful for “knocking” black out of a layer.  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Overlay 
Overlays existing pixels while preserving highlights and shadows of base. 

Soft Light 
The effect is similar to shining a diffused spotlight on the image. 
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Hard Light 
Effect is similar to shining a harsh spotlight on the image. 

Difference 
Evaluates each channel and subtracts or inverts depending on brightness. 
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Subtract 
Looks at the color in each channel and subtracts the blend from the base.  

Hue 
Uses luminance and saturation of the base and the hue of the blend. 
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Color 
Preserves gray levels. It’s very useful for coloring and tinting. 

Luminosity 
Is the inverse effect from the Color mode. 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Masking Options in Luminar 

The use of masks allow you to hide or obscure parts of an image. Masks are useful so you can 
combine the contents or results of one layer with your primary image. Layer Masks allow you to use 
powerful painting tools to control their results. The more you work on combining multiple images, 
the more you’ll use masks.  
Luminar offers 4 types of masks: 

• Brush. The Brush is one of the easiest ways to mask an image.  You can use brush strokes to 
add or subtract from the mask. 

• Radial Mask. The use of a Radial 
Gradient Mask is a quick, easy 
way to highlight an area of your 
photo with an elliptical shape. 

• Gradient Mask. The Gradient 
Mask Tool is useful for creating a 
gradual blend between two 
states or layers. 

• Luminosity. A Luminosity Mask 
is a fast and easy way to create a 
new mask based on the 
brightness of image pixels. 

Creating a Layer Mask 
If you’d like to use a mask on a layer, the first step is to add one.   This approach is most useful when 
you want to globally mask parts of an image layer or to blend several filters at once. This mask can 
be edited using the Brush, Radial Mask, or Gradient Mask tools. 
To add a mask: 

1. Open a photo within Luminar 2108. 
2. Select the desired layer. By default, layers and adjustment layers have no mask. 
3. Click the Edit Mask button. 
4. Choose one of the four mask types 

• Brush 

• Radial Mask 

• Gradient Mask 

• Luminosity 

These tools offer several controls, we’ll explore them next. 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Painting a Mask 
Once you’ve added a mask, you can now add or subtract using a variety of tools. You can freely 
switch between the Brush, Radial Mask, and Gradient Mask tools while working.  Once you’ve 
chosen one of these tools, a new toolbar appears.  Let’s explore the essential controls. 

Global Mask Controls 
Once you start to edit a mask, you’ll see global mask controls.  These make it easier to visualize a 
mask or edit its contents. These controls are found under the Mask menu in the toolbar. 

• Fill. This option attaches a mask filled with white that 
reveals all details of the filter.  Use the Brush tool to 
paint with black and subtract from the mask. 

• Invert. Inverts any mask that you’ve created so that its 
opacity and transparency values are reversed. 

• Clear. This option hides the results of the filter 
entirely.  Use the paint brush or gradient tools to add 
details back to the image. 

• Copy. Copies the current mask to the clipboard. To 
use this, create a new layer and paste it into the new 
layer. 

• Paste. Pastes the current mask stored on the 
clipboard for use on another layer. 

• Show Mask/Hide Mask. This controls the visibility of 
the mask.  It makes it easy to view the mask as a 
rubylith (red) overlay. You may also continue drawing 
while the layer mask is shown, for even more precision. Alternatively you can click the 
eyeball icon. 

• Density (Only for Brush Tool). Controls the transparency of pixels outside of a mask so the 
overall the mask fades into the background better. 

• Feather (Only for Brush Tool). Blurs the edges of a mask to more naturally fade the mask 
adjustments into the image. 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Mask Tool Controls 
The next controls affect how you can add or subtract from your mask.  Luminar 2018 offers three 
tools that you can use to paint a mask. 

• Brush. Use a paintbrush to add or subtract from your mask. 

• Radial Mask. Creates an elliptical shape to blend between affected and unaffected areas. 

• Gradient Mask. Creates a linear blend between affected and unaffected areas. 

Using a Brush Mask 
The Brush can be used in either Paint mode or Erase mode to add to or subtract from areas of the 
mask. Clicking on the Paint option will add white areas to the mask.  These areas will be preserve 
the current layer.  Brushing with Erase mode is handy for “trimming” overspray of the mask and 
making your selection more accurate. 
To control a brush, click the Brush Settings dropdown menu (it’s next to the Erase option). In this 
window, you can configure all the paint brush settings such as Size, Opacity and Softness. In the 
center of the grid there are various presets for quick selection. If you have a pen tablet attached, 
you can also configure Pen Pressure, Radius and Opacity levels. 
Here’s how to use the Masking Brush tool. 

1. Open an image in Luminar 2018 

2. Click the Add Layer button (+ symbol) or choose Layers > Add New Adjustment Layer.  
Let’s add an obvious effect so its easy to view.   

3. With the adjustment layer selected, click the Add Filters button. 
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4. Apply the Dramatic effect and increase the sliders to a high setting. 

5. Create a Layer mask on the adjustment layer by clicking the Edit Mask button.  

6. Choose Brush from the pop-up list. 
You now have two options to decide how the initial mask is created. 

• Paint. Clicking with the Paint tool fills the mask with black (hiding all of its results).  As 
you paint and add strokes they are added in white.  This method allows you to brush and 
add the results of the Adjustment layer selectively. 

• Erase. Clicking with the Erase tool fills the mask with white (showing all of its results).  As 
you paint and add strokes they are added in black.  This method allows you to brush and 
subtract the results of the Adjustment layer selectively.  The erased areas will show 
through to the image below. 

7. Click the Visibility icon (eyeball) to view the Mask. 

8. Brush with the Brush tool to add the results to the layer selectively. 

9. Continue painting the mask to get the desired results.  Use the toolbar at the top of the 
window to control the behavior of the Masking Brush tool. Click the Brush Settings drop-
down menu to control the shape and dynamics of the brush. You can also click on each 
property in the top toolbar to edit them individually 

• Size. Controls the diameter of the brush.  You can also use the keyboard shortcuts [ and ] 
to make the brush smaller or larger. 
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• Softness. Controls how much blending there is between the center of the brush and its 
edges.  This can create a more gradual blend on any mask.  You can also use the 
keyboard shortcuts of Shift + [ or ] to make the brush harder or softer. 

• Opacity. This controls the overall opacity in the brush.  A brush at 100% has full impact.  
A brush set to 50% will only add or subtract half of its strength. 

• Pen Pressure. If you have a pen tablet attached, you can also configure Pen Pressure, 
Radius and Opacity levels. This allows you to draw on the tablet and have the force 
applied to the pen transfer to the size and density of the brush. 

10. Click and paint on the canvas to modify the selected mask 
(layer or adjustment layer). 

11. To refine the mask even more, click the Mask Menu to modify 
the Density and Feathering for the mask.  This can control how 
the mask applies and help blend its results more. 
• Density. Controls the transparency of pixels outside of a 

mask so the overall the mask fades into the background 
better. 

• Feather. Blurs the edges of a mask to more naturally fade 
the mask adjustments into the image. 

12. Toggle the mask visibility off by clicking the Visibility icon 
(eyeball) in the toolbar.   

13. When satisfied with the mask, click the Done button in the 
toolbar. 
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Using a Radial Mask 
The use of a Radial Gradient Mask is a quick, easy way to highlight the sun, a face or anything else 
on your photo.  You can create an ellipse or circular shape that makes its easy to create a gradual 
blend between two states.  It can be used with an image layer to add ramping transparency.  For an 
adjustment layer, it’s useful to create a blend between the modified and original state.  
Here’s how to use the Radial Mask tool 

1. Create a Layer or Adjustment Layer mask as previously discussed in this chapter.   
2. Click the Edit Mask button on the layer. 
3. Select the Radial Mask option from the dropdown. 

4. Click and drag to create a circular gradient.   
5. Click the Visibility button in the top toolbar to make it easier to visualize the gradient. 
6. The tool offers simple controls to refine the gradient. 

• Drag the middle of the gradient (the dot) to place its center. 

• Drag the inside circle’s radius to affect the size of the gradient. 

• Drag the outside circle’s radius to affect the feathering of the gradient. 

• Drag a handle on the outside circle to adjust the aspect ratio to create an ellipse shape. 

• Drag outside the outer circle to rotate the gradient mask. 

7. You can change the mode of the mask if you need to change how a mask is applied by 
clicking the Invert button. By default the Radial Gradient mask that is created will “protect” 
the center of the circle/oval and any enhancements will be applied outside of the inner 
circle. Click this button to invert the mask so that effects will be applied TO the inner circle. 
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8. You can also adjust properties like Blending modes and Opacity to change the masks 
impact on the image. 

9. When satisfied with the mask, click the Done button.   
10. If using an Adjustment Layer, adjust the Filter controls as needed.  The mask will control how 

its results are applied. 

__________________________________________________ 
TIP 
You can edit the results of a Radial mask by clicking the Edit Mask button.  This lets you add or 
subtract from the mask using the Brush tool for greater control over the mask. 
__________________________________________________ 
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Using a Gradient Mask 
The Gradient Mask Tool is useful for creating a gradual blend between two states.  It can be used 
with an image layer to add ramping transparency.  For an Adjustment Layer, it’s useful to create a 
blend between the modified and original state. The Gradient Mask is a favorite tool of landscape 
photographers that allows you to enhance images smoothly with effects applied to the Gradient. 

1. Create a Layer or Adjustment Layer mask as previously discussed in this chapter.   
2. Apply an effect or preset to the adjustment layer. 

3. Click the Edit Mask 
button on the layer. 

4. Select the 
Gradient Mask 
option from the 
dropdown. 

5. Click and drag to 
create a linear 
gradient.   

6. Click the Visibility 
button in the top 
toolbar to make it 
easier to visualize 
the gradient. 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7. The tool offers simple controls to refine the gradient. 
• Drag the top bar or bottom bar to expand or contract the gradient. 

• Drag the middle dot to position the gradient. 

• Drag the bottom bar to move the end of the gradient 

• Click and drag just outside the center point to rotate the gradient mask. 

• Drag a handle on the outside circle to adjust the aspect ratio to create an ellipse shape. 

• Drag the inside handle to rotate the gradient mask. 

8. When satisfied with the mask, click the Done button.   
9. If using an Adjustment Layer, adjust the Filter controls as needed.  The mask will control how 

its results are applied. If using an image layer, you can control the opacity and blending 
mode of the layer. 

__________________________________________________ 
TIP 
You can edit the results of a Linear mask by clicking the Edit Mask button.  This lets you add or 
subtract from the mask using the Brush tool for greater control over the mask. 
__________________________________________________ 
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Luminosity Masks 
A Luminosity Mask is a fast and easy way to create a new mask based on the brightness of image 
pixels.  When selected, the command will fill the active layer with a mask based on the brightness of 
image pixels. The transparency for the layer is directly related to the brightness of the pixels. 
This command works very well to mask an overlaid image such as a cloud or texture layer. You can 
also mask a copy of a layer to enhance only part of an image. For example, if the sky and clouds are 
bright, you can create an exact mask only for that area of the image and then enhance them. 
Heres how to create a Luminosity Mask: 

1. Open a photo within Luminar 2018. 
2. Make any adjustments needed with the Develop filter. 

3. Apply and adjustment layer to stylize the image. 
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4. In the Layers controls click the + button and choose the Add New Image Layer option. This 
can be useful to blend back key details. 

5. Click the Edit Mask button on the layer. 
6. Select the Luminosity Mask option from the 

dropdown. 
A new mask is created based upon the 
brightness of the image. 

7. If the mask is showing unwanted areas, you 
can click on the Edit Mask button and choose 
Brush. 

8. Now you can use the Mask menu to invert the 
mask or use the Brush tool to add or subtract 
from the mask. 

9. You can also re-run the Create Luminosity Mask 
multiple times to generate different masks each time. 

10. Use the layer’s blending mode and opacity sliders to blend the layer to taste. 
__________________________________________________ 
TIP 
When editing a mask, you can press the Backspace hotkey to reset a gradient/radial mask to its 
default setting. 
__________________________________________________ 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Masking Options 
Here are some extra techniques you can use when masking a layer or adjustment layer. 

• While masking or erasing, right-clicking the mouse causes a context window of parameter 
settings of the brush, and includes additional controls for pen pressure sensitivity. 

• For handy reference, in the Layers panel on the upper right side of the Side Panel, you’ll see 
a thumbnail image of the current mask. 

• To quickly switch between Paint and Erase modes, use a shortcut key X. 

• To quickly change the Diameter of the brush, use the shortcut keys [ and ]. This is very 
convenient and greatly speeds up brush work. 

• To quickly change the Softness of the brush, use the shortcut keys Shift + [ and Shift + ]. 

• If you hold down the space bar in Painting mode you can switch to Move the image mode.  
This is very convenient when zoomed in for detailed brush strokes. 
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Creating a Filter Mask 
Another way to apply a mask is directly to a filter.  This workflow allows you to isolate the results of a 
specific area.  Perhaps it’s to enhance just the sky or to add details to a specific area of an image.  
The use of the Gradient Mask and Radial Mask mode can be helpful to smoothly blend a filter. 
To create a Filter Mask: 

1. Select an individual filter in the Filters area. 
2. Click the Filer Mask button (the paintbrush icon). 
3. Choose from one of the four types of masks: Brush, Radial, Gradient, or Luminosity. 

4. Use the techniques covered in this chapter to edit the mask. 
5. When satisfied with the mask, click the Done button. 
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Removing an Object   

The process of making a photo look better is often referred to as retouching (while repairing 
damaged photos is referred to as restoration). Luminar offers two useful tools to make these kind of 
tasks easier. Let’s explore how the tools work and when you might choose one over another..  

Using the Clone & Stamp Tool 
The Clone & Stamp tool works by replacing unwanted or damaged pixels with good pixels that you 
target. This tool is easy to use and allows you to set a sample point (where the good pixels are taken 
from), and then paint into bad areas (to cover up damage or blemishes). Luminar offers feathered 
brushes to make the blending of strokes easier. 

1. Open an image that needs cloning and stamping. 
2. Switch to the Clone & Stamp Tool by click its button in the top toolbar or pressing Cmd+J. 
3. Use the Zoom buttons and the Hand tool to explore the image’s details. 
4. When you find an area to Clone & Stamp, hold down the Option key and click on a clear 

area near the damaged pixels or skin blemishes. 

5. Click and brush over the damaged area.  
6. Click and paint out the pixels you want to remove. You can also try small dabs and short 

strokes to get a blended look. The sampled pixels are taken from the sample point and 
cover the unwanted pixels. Try blending multiple strokes together and lower the opacity of 
the brush for the best results. 
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7. After each stroke, the screen blends and updates to show the new pixels.  Continue to 
examine the results and make additional strokes as needed. 

8. When happy with the pixel removal, click the Done button. 
__________________________________________________ 

Note 
Here are some practical tips to get better results using the Clone & Stamp tool. 

• Try cloning at a low opacity and build up strokes. 
• Try sampling from several different places to fill in an area. 
• Experiment with blending modes. 

__________________________________________________ 

Page !  of !135 155



Using the Erase Tool 
The Erase tool serves a similar purpose to the Clone & Stamp tool, it’s all about removing unwanted 
objects or details.  But its approach is a bit different.  Rather than Option-clicking to set a source 
pint for pixels, you simply click and paint over the unwanted areas.  Luminar then examines the 
surrounding pixels and generates a new texture based on its awareness of what’s nearby in the 
photo. The Erase tool also matches the texture, lighting, and shading of the original pixels. This 
approach is often quite effective as the tool is fast and easy to use. 

1. Open an image that has items you’d like to erase and remove from the image. 

2. Switch to the Erase Tool by clicking the Tools menu in the top toolbar. 
3. Use the Zoom buttons and the Hand tool to explore the image’s details.  

You can use the keyboard shortcut Cmd+= to zoom in.  Simply hold down the spacebar to 
switch to the hand tool. 
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4. When you find an area to Erase, simply click and brush over the unwanted area.  
5. You can adjust the size and hardness of the brush with the toolbar at the top of the screen. 
6. To subtract from the targeted areas, press the X key to toggle between adding and 

subtracting pixels with the brush. 

7. If you have a large area to select, choose the Polygonal Lasso tool.   
8. Click to draw several points to create the desired shape. 

9. When you have a basic selection, click on the first point to close the loop. 
10. Click the Erase button to remove the selected areas. 

11. When happy with the pixel removal, click the Done button.  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Crop & Transform a Photo 

Directly out of a camera, your digital photos will likely not be sized to the exact dimensions you 
need.  Between different shaped screens, web pages, social networks, and prints its often common 
to change the shape and size of an image. Inside of Luminar you have two options, cropping which 
changes the shape of a photo and transforming which scales the image inside the canvas. You can 
use these choices individually or in combination to achieve the desired results.  

Cropping a Photo 
1. Open an image that needs cropping or straightening. 
2. Switch to Crop Tool by clicking the Tools menu or press the C key.  

After pressing this button, the application enters Crop Tool Mode. 
3. Examine the top Info Bar which displays all functions for cropping an image. The image is 

displayed with a grid that represents the ratio chosen in the Ratio dropdown menu. 

4. Choose a Ratio from the Aspect dropdown menu. 
• Free – Create a custom shape by dragging to taste. 
• Original – Preserves the original shape of the photo but allows you to crop more tightly 

to remove details from the edges 
• Transposed – The original dimensions are reversed for the crop. 
• 16:10 – A ratio that matches many computer displays. 
• 16:9 – A ratio used by televisions, many electronic devices and presentations 
• 11:8.5 – A common size for documents. 
• 7:5 — A rectangular image that’s common for many photo sizes 
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• 5:4 – A near-square image that’s common for many photo sizes 
• 4:3 – A rectangular image that’s common for many photo sizes 
• 3:2 – A rectangular image that’s common for many photo sizes 
• 1:1 – A square shaped image is created 
• 2:3, 3:4, 4:4 5:7, 8.5:11, 9X16, and 10:16 – Presets that match the standard print and 

screen ratios, but with their values transposed. 
• Facebook Cover – A useful size for a page banner on Facebook. 
• Facebook Feed – A common size for an image post to Facebook. 
• Enter Custom… – Offers the ability to choose a specific aspect ratio. 

5. Choose a ratio overlay to help with cropping. 
• Rule of Thirds – This is a standard overly 

used to help cropping. The four 
intersecting points are considered  the best 
place to put a subject.  Many feel that 
following these guides makes an image 
appear better. 

• Phi Grid — The phi grid is similar to the rule-of-thirds grid. The difference is that the 
parallel lines are closer to each other and to the center of the frame, and the nine boxes 
are not all the same size. This grid can better accommodate the Golden Ratio.  Many 
landscape photographers feel that this is a better guide for composition rather than the 
rule of thirds.  

The Rule of Thirds overlay on the left is the default overlay when cropping. The Phi Grid on the right is an 
alternative overlay to help when cropping. 

6. Drag any of the corners or resize handles to modify the cropping rectangle. 
7. To Move the image inside the crop, just click inside the image crop area and drag to 

reposition the image “behind” the cropping rectangle. 
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8. To Rotate an image you can click on the Angle readout to reveal a drop-down slider for 
adjusting the angle of the image up to 45 degrees in either direction. You can also click and 
drag just outside a corner to rotate.  A grid overlay appears to help you with accurate 
cropping. 

9. When happy with the cropping, click the Done button. To cancel this action click Reset and 
then Done.  
If you do not like the result, you can easily undo the cropping by pressing the Undo button. 
Hence cropping is a safe operation that can be easily undone. 
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Transforming a Layer 
Once you’ve added a new layer to a document, it’s easy to transform it to a new size.  The Free 
Transform tool works similarly to the Crop Tool. 

1. Click the + symbol at the top of the Layers panel and choose Add Image…. 
2. Navigate to a logo, watermark , or layer on your hard drive and click the Open button to add 

the file to your document.  The layer is automatically named with the filename of the 
selected file. 

3. To scale the texture, right-click on its thumbnail and choose Image Mapping. 
4. To prevent unwanted distortion of the watermark or logo, choose Fit.  

5. To scale the layer, click the Free Transform Tool or press Cmd+T. 
6. If you want the layer to not distort, click the Lock icon in the Info Bar to prevent unwanted 

distortion. 

7. Drag a corner handle to resize the layer.  Drag in the center to position.  Resize and position 
the logo to taste. 

8. To Move the image, just click inside the image area and drag to reposition the image. 
9. To Rotate an image you can click on the Angle readout to reveal a drop-down slider for 

adjusting the angle of the image up to 45 degrees in either direction. You can also click and 
drag just outside a corner to rotate.  A grid overlay appears to help you with accurate 
cropping. 
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10. When happy with the position of the new layer, click the Done button. To cancel this action 
click the Reset button than click Done.  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Saving & Exporting Files 

As you work with digital images, at some point you’ll reach a point where saving a file is a good 
idea.  It might be an in-progress save to capture work to date as you edit a photo.  Perhaps it’s to 
prepare a file for printing or sharing on the Internet.  Or maybe an export to social media.  Luminar 
offers many different options for saving and exporting images to meet your needs. 

Saving a Native Luminar File for Future Edits 
As you design using layers, filters, and masks… it’s a good idea to capture that work from time-to-
time. To make this easy, Luminar offers a native file format, the Luminar project file (its file extension 
is .lmnr).   

1. To save your work in progress, press Cmd+S on your keyboard or choose File > Save….  
A new dialog opens. 

2. Choose a new location to store the saved file on your hard drive, an attached disk, or using a 
Cloud storage provider. 

3. You can check the Save original resources and Save history options for more flexibility 
when editing in the future.  If you want to edit the document on a Windows computer, 
please be sure to check the Windows compatible option. 

4. Give the file a descriptive name and click the Save button to write to disk.  
Your work is saved in its current state so that you can later continue from the same point.  
The file is saved in the proprietary Luminar file format and cannot be opened with another 
application. For other software to use images created using Luminar, you’ll need to Export 
the file (see below) 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Exporting Images 
While saving a native Luminar file is important, you may also need to export multiple files for other 
tasks.  Maybe its to post online, to drop into a presentation, or to collaborate with others. When you 
export a file, you can save in a variety of file formats including JPG, TIFF, PNG and even PSD. Each 
file format has its own unique set of parameters which are standard macOS system options. 

Saving an Image File 
You can also save image files from your Luminar project. These files are broadly compatible with 
many other applications. To create a new graphic file. 

1. It is first suggested that you save a native Luminar project first using the File > Save 
command. 

2. To create a new graphic file choose File > Export or click the Share image button in the 
upper right corner and choose Export to image….  A new dialog box opens. 

3. Choose a new location to store the saved file on your hard drive, an attached disk, or using a 
Cloud storage provider. 

4. Select from the following optional items: 
• Sharpen. Choose whether you want to Sharpen the exported file. This can increase 

details in the edges of the image and overcome some of the compression artifacts of 
formats like JPEG. 

• Resize. You can choose to export at the original size, or to enter a new dimension for the 
image to fit its long side or short side.  
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• Color Space. You can choose from 3 color spaces for output.   
• sRGB is the narrowest color gamut, but most compatible with the web 
• Adobe RGB is a common color space used in computer graphics and many 

software applications.  
• ProPhoto RGB is the widest gamut and supports the broadest range of colors. 

ProPhoto RGB is the only color space that can contain all the colors captured in a 
raw format photo. 

• Format. Choose from eight different file formats.  Some options like TIFF and JPEG may 
offer additional settings for control over compression and bit depth. 

• Quality. Some formats (like JPEG) allow you to assign a Quality setting which will affect 
overall compression and the final file size. 

5. Give the file a descriptive name and click the Save button to write to disk. 

Supported File Formats 
The following types of file can be created in Luminar. 

• JPEG (.jpg). The Joint Photographic Experts Group (JPEG) format is most often used to 
display continuous-tone images (such as photos) on the Internet. Most digital cameras use 
JPEG because it provides excellent compression; the maximum setting provides 
comparable image quality to much larger file formats like TIFF. Occasionally, the print 
industry (especially newspapers) will use JPEGs. JPEG is a lossy compression, which means 
that some data is discarded during compression of the image. JPEGs should not be used as 
an archive or production file format. You should generally only save JPEG files once, 
because re-saving continues to discard data and lower image quality. If you have acquired 
an image as a JPEG in your camera, be sure to save the edited document as a native 
Luminar file. 

• PNG (.png). The Portable Network Graphics format provides lossless compression. It is 
increasingly common on the Internet, as most web browsers support it. The PNG format was 
created to be a patent-free alternative to GIF. Its major advantage is the PNG-24 file, which 
allows for 24-bit images (8 bits per channel) and embedded transparency. It is technically 
superior to GIF. 

• GIF (.gif). The online service provider CompuServe originally developed the Graphics 
Interchange Format (GIF). This format displays 8-bit or indexed-color graphics and images in 
HTML documents on the Internet. You’ll hear the file called both “giff” and “jiff”; both are 
acceptable. GIFs use a color table (with no more than 256 colors total, not per channel) to 
represent the image. This can lead to a small file size but also banding in the image. In most 
cases a JPEG is a better option for web delivery. 
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• TIFF (.tif). The Tagged-Image File Format is one of the most common and flexible formats 
available. It is widely used to exchange files between applications and computer platforms, 
and has a long legacy of compatibility.  Additionally, TIFF is one of the formats to work in a 
bit depth of 8 or 16 bits per channel.  

• JPEG 2000 (.jp2). The JPEG 2000 format is an update released in the year 2000 from the 
Joint Photographic Experts Group committee.  Its intent was to replace the original JPEG 
format.  It uses a newer wavelet-based method of image compression which is more 
efficient. 

• Photoshop (.psd). The Photoshop format is a common format used in the computer 
graphics industry.  Skylum cannot write a layered file, but can export a file that can be 
opened by Adobe Photoshop and other software packages which support the format. 

• PDF (.pdf). The Portable Document Format (PDF) is a file format invented by Adobe and was 
intended to be an extension of PostScript. A PDF can be viewed on virtually every operating 
system and portable media player or phone. The PDF is an open standard, which means that 
the computer industry is able to create applications that can read or write PDFs without 
paying Adobe additional fees. This openness led to the quick adoption of PDF, and it is 
utilized online extensively. 

Open an Image in Other Skylum Apps 
Luminar is part of a bigger set of tools from Skylum. You can easily send your image to other Skylum 
software products for additional enhancement or correction.  Just click File > Open In and select a 
targeted application. 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• Aurora HDR. The world's most advanced HDR photo editor. 

• Intensify CK. Boost details and add drama. Make your photos stand out 

• Tonality CK. The next generation black & white photo editing 

• SnapHeal CK. Easily remove unwanted objects from photos with the World’s most 
advanced image healing algorithms. 

• FX Photo Studio CK. Stunning filters and photography effects for unlimited creativity 

• Focus CK. Highlight the most important subject on your photo 

• Noiseless CK. Noise reduction software, designed to make noisy photos look their best. 

If you’ve installed Luminar as a plug-in or extension to other applications (see Installing “Luminar 
2018 as a Plugin”) then other applications may appear. 

• Aperture. Apple’s original professional photo editing application which is discontinued. 

• Photoshop. Adobe’s professional image touch-up and restoration program. 

• Elements. Photoshop Elements is a simplified version of Photoshop and is Adobe’s 
consumer photo editing application 

• Lightroom. Luminar works with Lightroom Classic CC or Lightroom 6. 

• Photos.  Photos for Mac is a photo management and editing application from Apple. 

Open an Image in other Apps or Services 
If you’d like to send your image to another application or 
service, that’s easy too.  Luminar integrates with several 
other applications and web services to make sharing your 
finished photo (or a work in-progress) fast and simple. Just 
click File > Share To or click the Share Image button in 
the upper right corner and select a targeted application. 

• Mail. Attach a JPEG to a mail message. 

• Messages. Send a photo as a text or instant 
message, 

• Twitter. Add an image to your Tweet, 

• Facebook. Add an image to your post, 

• Flickr . A photo sharing community with free and paid memberships. 

• SmugMug . An online gallery community for selling prints. 

• 500px.  A photo sharing community with free and paid memberships. 

You may need to separately have an account on these services to access them within Luminar.  If an 
application isn’t installed on your machine, it will be grayed out in the menu  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Batch Processing Photos 

If you have several images from one photo shoot, you can often save time by applying the same 
develop settings to multiple photos.  This is particular helpful to those who should events, sports, 
and other types of photography where a lot of images are shot under similar conditions. The Batch 
Processing feature is very versatile and contains many options that you can conveniently apply to a 
large set of images.  

Getting Started with Batch Processing 
Let’s start the batch process. 

1. The first step is to load the photos you want to develop.  This can be done a few ways: 
• Choose File > Batch process. 

• Press Cmd + B. 

• Choose Batch Process in the welcome screen 
A new window opens.   
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2. You must now load the images you want to batch process. To do so you can: 
• Drag files or folders into the Batch Process window 

• Click the Browse button. 
If the “Include Subfolders” option is checked and you’ve added folders, then Luminar 
2018 will search for all images in every subfolder of the added folders.  Give the 
application a little time to analyze the images. 

3. After the images you wish to process have been selected, press the Continue button to 
reveal options and settings for Batch Processing. 
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Batch Processing Settings 
The Batch Processing feature is very versatile and contains many options that you can conveniently 
apply to a large set of images. Here are the options you have available:  

Default Settings 
In the upper left corner of the dialog are useful presets to configure how the batch process will run.  
These change all of the options for what type of files are generated (however you should still 
specify a destination).  Bundled preset include: 

• Web JPEG. Creates files ready to post to websites. 

• For Email. Creates smaller files optimized for email. 

• Last Use.  The settings from the previous time using the Batch Process command. 

User Settings 
This section contains any custom workflows you’ve created.  These can be made using the settings 
on the right.  To store the Batch Process settings for later click the Save Settings button at the 
bottom of the window. Be sure to give the preset a descriptive name, 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Batch Settings 
When you ready to configure the batch process, there are several useful settings to choose from. 

• Preset. The Preset controls let you choose from any Luminar preset.  This includes all 
bundled presets, installed presets, and user-generated ones. First, choose the Category and 
then the individual Preset. You can use the Amount slider to refine the preset’s strength. 

• Save to. This option lets you choose where processed files will be saved. You can save them 
in their current location or browse to select another folder. When you’ve made a choice, the 
file “path” will be displayed. Note: Because it is possible to overwrite your original files, it is a 
good practice to save your batch-processed files into a new folder separate from the original 
files. 

• Naming. Luminar 2018 has very flexible file naming options. You can add a prefix and suffix, 
choose from a variety of base names and even select the case of the letters. This gives you 
tremendous flexibility to organize your files as part of the batch processing operation. 

• Format. Choose way type of file should be created.   You can make a JPEG, JPEG-2000, 
PNG, PDF, TIFF or PSD file during the batch processing. 

• Color Profile. This controls how the colors are interpreted.  Options include sRGB, Adobe 
RGB, and ProPhoto RGB 

• Resize. Easily choose a dimension for the new files. 

Running the Batch 
After selecting your desired Batch Processing options, click the Continue button in the lower right 
of the window to begin the operation. This will display a processing window showing progress. 

• To return to the Image Selection window and select different images prior to beginning a 
Batch Processing operation, click the Back button in the lower left of the window.  

• To cancel Batch Processing altogether, click the “X” in the upper-left corner of the window.  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Keyboard Shortcuts 

General 
\  Activates before/after comparison. When the key is pressed, the original image will be 

shown. Releasing the key will reveal the enhanced image. 

;  Activates split-screen comparison mode where the original image is on the left side and 
the edited result will be on the right side. To exit the mode press the ; button again. 

Tab  Show/hide the Preset panel at the bottom of the window and Side panel along right 
edge.  The key will activate previously shown windows. 

F Activates Full Screen Preview for a very large image with no user interface. 

Luminar Menu 
Cmd+H Hide Luminar 

Cmd+Q Quit Luminar 

File Menu 
Cmd+O Opens an Image 

Cmd+W Close File 

Cmd+S Save a File 

Shift+Cmd+S Move To… 

Shift+Cmd+F Show Original File in Finder 

Shift+Cmd+E Export to Image 

Cmd+B Opens Batch Processing Mode 

Shift+Cmd+P Page Setup 

Cmd+P Print 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Edit Menu 
Cmd+Z Undo 

Shift+Cmd+Z Redo 

Cmd+X Cut 

Cmd+C Copy 

Cmd+V Paste 

Image Menu 
Cmd+[ Rotate Left (CCW) 

Cmd+]  Rotate Right (CW) 

Tools Menu 
H Activate the Move tool 

B Activate the Masking Brush tool 

G  Activates the Gradient Mask tool 

R  Activates the Radial Mask tool 

J  Show/hide the display of “hot” and “cold” pixels. These are completely black and white 
pixels on an image 

Cmd+T Free Transform tool 

Cmd+J Clone & Stamp tool 

Cmd+E Erase tool 

C  Enter the Crop tool  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Mask Editing 
[    Decrease the brush radius 

]    Increase the brush radius 

Shift+[   Decrease the brush softness 

Shift+]   Increase the brush softness 

X   Switching between painting/erasing modes 

/  Show current layer mask in the form of red transparent image imposition 

Cmd+I  Invert the layer mask 

View Menu 
Cmd++ Zoom In 

Cmd+- Zoom Out 

Cmd+1 Original Size 

Cmd+0 Fit to Screen 

J  Show/Hide Clipping 

I  Show/Hide Image Info 

;  Compare 

Ctrl+Cmd+F Enter Full Screen 

F  Show a full-screen preview of just the image 
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Keeping Luminar Up to Date 

Luminar has a handy automatic update feature to address updates, new features, enhancements 
and bug fixes. To ensure you’ve got the latest release, open the software and choose the  Luminar 
2018> Check for Updates… menu. 
This will launch the Skylum update service and automatically grab any updates you need. Follow 
any prompts relating to installation and/or restarting the software. You may also need to input your 
Administrator Password and update the Plug-ins for your other applications. 

Thank you.  

If you have questions, contact Luminar 24/7 support at support@skylum.com.  

You can also visit our support community forum at http://bit.ly/skylum_community.  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